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ΠΕΡΙΛΗΨΗ 
 
 
 

Στην παρούσα πτυχιακή εργασία με τίτλο «Μελέτη παλμικής ροής αίματος σε 
πρότυπη αρτηρία με την χρήση του υπολογιστικού προγράμματος FLUENT» 
παρουσιάζεται μια μελέτη παλμικής ροής αίματος σε πρότυπη αρτηρία (αορτή) 
θεωρώντας δύο περιπτώσεις. Στην μία περίπτωση θεωρούμε το αίμα μη νευτώνειο 
ρευστό και στην δεύτερη νευτώνειο ρευστό. Σκοπός της συγκεκριμένης πτυχιακής 
είναι να γίνει μοντελοποίηση της αρτηρίας με χρήση του κατάλληλου υπολογιστικού 
πλέγματος και να εξαχθούν αποτελέσματα για διάφορα μεγέθη που μας ενδιαφέρουν, 
όπως πίεση, ταχύτητα ρευστού, τάσεις τοιχωμάτων και άλλα. Επίσης θα βγάλουμε 
ένα συμπέρασμα για το αν υπάρχει μεγάλη διαφορά στις τιμές των διάφορων 
μεγεθών, όταν το αίμα το θεωρούμε μη νευτώνειο και όταν το θεωρούμε νευτώνειο.  

Στο πρώτο κεφάλαιο γίνεται μια αναφορά στο καρδιαγγειακό σύστημα του 
ανθρώπου και τα βασικά χαρακτηριστικά τα οποία το απαρτίζουν έτσι ώστε να 
έχουμε μία πλήρη εικόνα του συστήματος που μας ενδιαφέρει και μελετάμε. 

Στο δεύτερο κεφάλαιο γίνεται αναφορά στο υπολογιστικό πρόγραμμα που 
χρησιμοποιούμε για τις μοντελοποιήσεις, το οποίο ονομάζεται Fluent και επίσης 
γίνεται αναφορά στις βασικές μαθηματικές εξισώσεις που χρησιμοποιεί το Fluent για 
να επιλύει τα προβλήματα. 

Στο τρίτο κεφάλαιο χρησιμοποιούμε το λογισμικό ICEM CFD για την 
δημιουργία δύο υπολογιστικών πλεγμάτων και στην συνέχεια επιλέγουμε το βέλτιστο 
από τα δύο με κριτήριο τόσο το υπολογιστικό φορτίο, όσο και την ακρίβεια, έτσι ώστε 
να προχωρήσουμε την διαδικασία της προσομοίωσης. 

Στο τέταρτο κεφάλαιο αφού έχουμε επιλέξει το βέλτιστο πλέγμα ξεκινάμε τις 
προσομοιώσεις παλμικής ροής αίματος στην αρτηρία (αορτή) με την χρήση του 
προγράμματος Fluent και με χρήση δημιουργημένης συνάρτησης πίεσης για στρωτή 
ροή για δύο περιπτώσεις. Στην μία περίπτωση θεωρούμε το αίμα ως μη νευτωνικό 
ρευστό, που είναι και από την φύση του, ενώ στην δεύτερη το θεωρούμε νευτωνικό 
ρευστό. 

Στο πέμπτο κεφάλαιο παρουσιάζουμε τα αποτελέσματα των δύο 
περιπτώσεων προσομοίωσης με την βοήθεια του προγράμματος CFD-POST και 
Fluent και σχολιάζουμε τις διαφορές, αν υπάρχουν, μεταξύ των δύο περιπτώσεων 
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καθώς επίσης σχολιάζουμε και τις τιμές των διάφορων μεγεθών που μας 
ενδιαφέρουν. Επιπλέον μέσω προσομοίωσης διερευνήθηκαν οι περιπτώσεις 
υπέρτασης και υπότασης, ώστε να βρεθεί η επίδραση τους στην υπό μελέτη αορτή. 

Στο τέλος της πτυχιακής εργασίας παρουσιάζονται τα συμπεράσματα των 
προσομοιώσεων που πραγματοποιήσαμε. 

Αυτό το οποίο είναι πολύ σημαντικό είναι ότι μελετώντας μια πραγματική 
αρτηρία ενός ανθρώπου, παλμικής ροής, μπορούμε να εξάγουμε πολύ ικανοποιητικά 
συμπεράσματα για τα χαρακτηριστικά της ροής αίματος και της συμπεριφοράς της 
αρτηρίας κάτω από πραγματικές συνθήκες προσομοίωσης του καρδιαγγειακού 
συστήματος ενός ανθρώπου.    
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ΕΙΣΑΓΩΓΗ 
 
 
 

1. ΒΙΟΙΑΤΡΙΚΗ 
 

Η διάγνωση, η πρόληψη και η αντιμετώπιση σημαντικών ασθενειών με 
αποτέλεσμα ένα καλύτερο επίπεδο ζωής για τον άνθρωπο αποτελούν τον 
βασικότερο στόχο της βιοϊατρικής. Η βιοϊατρική τεχνολογία είναι η εφαρμογή των 
αρχών των θετικών επιστημών και των παραγώγων τους στην ανάλυση και την 
επίλυση προβλημάτων στους τομείς της ιατρικής και της βιολογίας. Ο όρος βιοϊατρική 
υπονοεί έμφαση στην ανάπτυξη τεχνολογίας για την διάγνωση και θεραπεία 
ασθενειών. Έτσι η μελέτη και προσομοίωση ροής αίματος σε πρότυπες αρτηρίες 
αποκτά μεγάλη σημασία για την εξαγωγή αποτελεσμάτων και συμπερασμάτων σε 
ερωτήματα που αφορούν την διάγνωση και την αντιμετώπιση καρδιακών παθήσεων. 

Οι καρδιακές/καρδιοαγγειακές παθήσεις αποτελούν μια από τις συχνότερες 
αιτίες θανάτου σε όλο τον κόσμο και αποτελούν αντικείμενο μελέτης και έρευνας από 
επιστήμονες. Η βασικότερη αιτία που οδηγεί σε καρδιακή ανεπάρκεια είναι η 
αθηροσκλήρωση η οποία θεωρείται ο πιο επικίνδυνος εχθρός της καρδίας και των 
αρτηριών. Μπορεί επίσης να οδηγήσει σε εγκεφαλικό, ρήξη ανευρίσματος των 
αρτηριών και θρόμβωση. Η αθηροσκλήρωση είναι η προοδευτική πάχυνση του 
εσωτερικού χιτώνα των αγγείων, με τελική συνέπεια τη μικρή ή μεγάλη στένωση ή 
απόφραξη του αυλού της που οφείλεται σε υπερβολική συσσώρευση πλάκας γύρω 
από το τοίχωμα της αρτηρίας. Η πλάκα φράζει την αρτηρία και διαταράσσει τη ροή 
του αίματος προκαλώντας σοβαρές καρδιαγγειακές επιπλοκές. Γίνεται εύκολα λοιπόν 
αντιληπτό ότι οι καρδιαγγειακές επιπλοκές έχουν ως αποτέλεσμα μεταβολές στη ροή 
του αίματος του κυκλοφορικού συστήματος. Για αυτό το λόγο είναι πολύ σημαντικό 
να πραγματοποιούνται μελέτες/προσομοιώσεις ροής αίματος σε αρτηρίες με σκοπό 
την θεραπεία των καρδιακών ασθενειών. 

Η ραγδαία τεχνολογική ανάπτυξη βοήθησε και στον τομέα της βιοϊατρικής 
καθώς έχουν δημιουργηθεί υπολογιστικά προγράμματα τα οποία έχουν την 
δυνατότητα να μελετούν την ρευστοδυναμική συμπεριφορά του αίματος και να 
εξάγουν συμπεράσματα για την κατάσταση του καρδιοαγγειακού συστήματος ενός 
ανθρώπου. 

Στην παρούσα πτυχιακή θα μελετήσουμε με τη βοήθεια ενός υπολογιστικού 
προγράμματος ρευστοδυναμικής, τη ροή του αίματος σε μια αορτή, η οποία είναι η 
μεγαλύτερη αρτηρία του σώματος, σε δύο περιπτώσεις. Στην μια περίπτωση θα 
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θεωρήσουμε το αίμα μη νευτώνειο ρευστό που είναι εξάλλου και από την φύση του. 
Στην άλλη περίπτωση θα το θεωρήσουμε νευτώνειο ρευστό, θεώρηση την οποία 
κάνουν πολλοί ερευνητές [16-17], διότι με βάση τα αποτελέσματα τα οποία εξάγουν, 
είναι μια καλή προσέγγιση. Θα εξαχθούν αποτελέσματα για τα μεγέθη της ταχύτητας, 
της πίεσης καθώς επίσης και των διατμητικών τάσεων που εμφανίζονται στα 
τοιχώματα της αορτής. Θα γίνει σύγκριση μεταξύ των δύο περιπτώσεων και 
σχολιασμός των αποτελεσμάτων. 
 
 
 

2. ΥΠΟΛΟΓΙΣΤΙΚΗ ΡΕΥΣΤΟΔΥΝΑΜΙΚΗ 
 

Η Υπολογιστική Ρευστοδυναμική (Computational Fluid Dynamics, CFD) είναι 
μία μέθοδος πρόβλεψης της συμπεριφοράς των ρευστών και βασίζεται στη χρήση 
αριθμητικών μεθόδων και αλγορίθμων για την επίλυση προβλημάτων που 
περιλαμβάνουν ροές ρευστών. Γίνεται χρήση υπολογιστών για την προσομοίωση της 
συμπεριφοράς των ρευστών αξιοποιώντας τις εξισώσεις συνέχειας και ορμής 
(εξισώσεις Navier-Stokes) σε συνδυασμό με τις εξισώσεις διατήρησης μάζας και 
ενέργειας, σε γεωμετρία και οριακές συνθήκες που ορίζονται από το χρήστη. 
Αποτελεί αποτελεσματικό και εύχρηστο εργαλείο προσομοίωσης της συμπεριφοράς 
των ρευστών του μηχανικού και μπορεί να χρησιμοποιηθεί για τη μελέτη της 
επίδρασης διαφόρων παραμέτρων (γεωμετρικά χαρακτηριστικά, ιδιότητες του 
ρευστού, οριακές συνθήκες) καθώς και στα χαρακτηριστικά της ροής (κατανομή 
ταχύτητας, πτώση πίεσης, μεταφορά θερμότητας, μεταφορά μάζας). Με 
υπερυπολογιστές υψηλής ταχύτητας, μπορούν να επιτευχθούν καλύτερες λύσεις. 

Οι εφαρμογές της υπολογιστικής ρευστοδυναμικής έχουν ένα τεράστιο εύρος 
σε πολλούς τομείς, όπως σε στροβιλομηχανές και ανεμογεννήτριες, στη ναυπηγική 
με κινούμενη διεπιφάνεια υγρού-αέρα (moving interface), στην χύτευση πλαστικού, 
στην αυτοκινητοβιομηχανία, στην αεροναυπηγική, στην επιστήμη των καιρικών 
συνθηκών, σε έργα πολιτικού μηχανικού, σε ωκεανογραφία αλλά και μη κλασικές 
εφαρμογές όπως στην ιατρική για τη ροή του αίματος. 
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ΚΕΦΑΛΑΙΟ 1: ΑΝΑΤΟΜΙΑ ΤΟΥ ΚΑΡΔΙΑΓΓΕΙΑΚΟΥ 
ΣΥΣΤΗΜΑΤΟΣ 

 
 
 

1.1 ΚΥΚΛΟΦΟΡΙΚΟ ΣΥΣΤΗΜΑ 
 

Το κυκλοφορικό μας σύστημα αποτελείται από το αιμοφόρο ή καρδιαγγειακό 
σύστημα και το λεμφοφόρο σύστημα. Είναι ένα κλειστό σύστημα κυκλοφορίας και 
αίμα εξέρχεται από αυτό μόνο όταν ένα αγγείο υποστεί βλάβη. Είναι διπλό σύστημα 
κυκλοφορίας διότι η καρδία λειτουργικά εξυπηρετεί το κύκλωμα της πνευμονικής ή 
μικρής κυκλοφορίας και το κύκλωμα της μεγάλης ή σωματικής κυκλοφορίας. 

Στην πνευμονική ή μικρή κυκλοφορία το αίμα φέρεται από την δεξιά κοιλία της 
καρδία με την πνευμονική αρτηρία στους πνεύμονες και επιστρέφει με τις 
πνευμονικές φλέβες στον αριστερό κόλπο της καρδίας. 

Στην σωματική ή μεγάλη κυκλοφορία το αίμα φέρεται με την αορτή και τους 
κλάδους της σε όλα τα μέρη του σώματος και επιστρέφει στην καρδία με την άνω και 
κάτω κοίλη φλέβα και με τις καρδιακές φλέβες. 

 
 

1.2 ΚΑΡΔΙΑ 
 

Κέντρο του κυκλοφορικού συστήματος είναι η καρδιά, η οποία διατηρεί την 
ροή του αίματος στον οργανισμό. Η καρδιά είναι κοίλος μυς που δίνοντας στο αίμα 
πίεση, το κάνει να κυκλοφορεί στο εσωτερικό των αρτηριών, με τέτοιο τρόπο, ώστε 
να φτάνει σε όλα τα όργανα. Είναι κάτι σαν «αντλία» που παίρνει το αίμα από τις 
φλέβες, στις οποίες βρίσκεται σε χαμηλή πίεση και το στέλνει στις αρτηρίες με υψηλή. 
Η καρδιά αποτελείται από ένα ειδικό τύπο σκελετικού μυ που βρίσκεται μόνο σε αυτή 
και αποκαλείται καρδιακός μυς και αποτελεί το μυοκάρδιο. 

Η καρδιά αποτελείται από τέσσερις μυώδεις κοιλότητες, δύο πάνω με λεπτά 
τοιχώματα τα οποία ονομάζονται κόλποι και δύο κάτω με παχύτερα τοιχώματα που 
ονομάζονται κοιλίες. Έχει βάρος σε ενήλικες από 250 έως 350 γραμμάρια και σε 
μέγεθος είναι περίπου όσο η μπουνιά του κάθε ανθρώπου. Βρίσκεται εντός του 



θώρακα μεταξύ των δύο πνευμόνων(κυρίως αριστερά) μεταξύ της δεύτερης και έκτης 
πλευράς πάνω από το διάφραγμα.

Η καρδιά διαθέτει τέσσερις βαλβίδες που χρησιμεύουν στο να επιτρέπουν την 
δίοδο του αίματος προς μία μόνο κατεύθυνση
του κατά την διάρκεια της καρδιακής συστολής.

Αυτές οι βαλβίδες είναι:  
 

· Η τριγλώχινα μεταξύ κόλπου και δεξιάς κοιλία
· Η πνευμονική μεταξύ δεξιάς κοιλιάς και πνευμονικής αρτηρίας
· Η μιτροειδής ή διγλώχινα μεταξύ αριστερού κόλπου
· Η αορτική μεταξύ αριστερής κοιλίας και αορτής
 

Οι τέσσερις βαλβίδες της καρδιάς ταξινομούνται σε δύο τύπους. Τις 
κολποκοιλιακές(μιτροειδής και τριγλώχινα) και τις μηνοειδείς(αορτική και πνευμονική). 
Κατά τη συστολή, οι κολποκοιλιακές βαλβίδες είναι κλειστές και οι μηνοειδείς 
βαλβίδες ανοιχτές. Στη διαστολή ισχύει το αντίθετο.

 
 

  
Εικόνα 1.1

1.3 ΚΑΡΔΙΑΚΟΣ ΚΥΚΛΟΣ 
 
Η κυκλοφορία του αίματος στηρίζεται στην συνεχή και ρυθμική σύσπαση της 

καρδιάς. Κατά την διάρκεια του καρδιακού κύκλου η καρδιά συνεχώς διαστέλλεται και 
συστέλλεται. Κατά την διαστολή το αίμα από τους κόλπους μετακινείται στις κοιλίες. 
Κατά την συστολή αρχίζει η σύσπαση της κοιλίας η οποία αυξάνει την ενδοκοιλιακή 
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θώρακα μεταξύ των δύο πνευμόνων(κυρίως αριστερά) μεταξύ της δεύτερης και έκτης 
πλευράς πάνω από το διάφραγμα. 

έτει τέσσερις βαλβίδες που χρησιμεύουν στο να επιτρέπουν την 
δίοδο του αίματος προς μία μόνο κατεύθυνση και να εμποδίζουν την παλινδρόμησή 
του κατά την διάρκεια της καρδιακής συστολής. 

Η τριγλώχινα μεταξύ κόλπου και δεξιάς κοιλίας 
Η πνευμονική μεταξύ δεξιάς κοιλιάς και πνευμονικής αρτηρίας 
Η μιτροειδής ή διγλώχινα μεταξύ αριστερού κόλπου και αριστερής κοιλίας και
Η αορτική μεταξύ αριστερής κοιλίας και αορτής 

Οι τέσσερις βαλβίδες της καρδιάς ταξινομούνται σε δύο τύπους. Τις 
κολποκοιλιακές(μιτροειδής και τριγλώχινα) και τις μηνοειδείς(αορτική και πνευμονική). 
Κατά τη συστολή, οι κολποκοιλιακές βαλβίδες είναι κλειστές και οι μηνοειδείς 
βαλβίδες ανοιχτές. Στη διαστολή ισχύει το αντίθετο. (Εικόνα 1.1) 

 

Εικόνα 1.1: Τα κύρια μέρη της καρδιάς [21] 
 

Η κυκλοφορία του αίματος στηρίζεται στην συνεχή και ρυθμική σύσπαση της 
καρδιάς. Κατά την διάρκεια του καρδιακού κύκλου η καρδιά συνεχώς διαστέλλεται και 
συστέλλεται. Κατά την διαστολή το αίμα από τους κόλπους μετακινείται στις κοιλίες. 

χίζει η σύσπαση της κοιλίας η οποία αυξάνει την ενδοκοιλιακή 

θώρακα μεταξύ των δύο πνευμόνων(κυρίως αριστερά) μεταξύ της δεύτερης και έκτης 

έτει τέσσερις βαλβίδες που χρησιμεύουν στο να επιτρέπουν την 
και να εμποδίζουν την παλινδρόμησή 

και αριστερής κοιλίας και 

Οι τέσσερις βαλβίδες της καρδιάς ταξινομούνται σε δύο τύπους. Τις 
κολποκοιλιακές(μιτροειδής και τριγλώχινα) και τις μηνοειδείς(αορτική και πνευμονική). 
Κατά τη συστολή, οι κολποκοιλιακές βαλβίδες είναι κλειστές και οι μηνοειδείς 

Η κυκλοφορία του αίματος στηρίζεται στην συνεχή και ρυθμική σύσπαση της 
καρδιάς. Κατά την διάρκεια του καρδιακού κύκλου η καρδιά συνεχώς διαστέλλεται και 
συστέλλεται. Κατά την διαστολή το αίμα από τους κόλπους μετακινείται στις κοιλίες. 

χίζει η σύσπαση της κοιλίας η οποία αυξάνει την ενδοκοιλιακή 
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πίεση. Όταν η ενδοκοιλιακή πίεση αυξηθεί αρκετά ανοίγουν οι μηνοειδείς βαλβίδες 
και το αίμα εξωθείται προς τις αρτηρίες. 

Ας αναφερθούμε τώρα στον κύκλο του αίματος στο σώμα με την βοήθεια της 
καρδιάς. Μπορούμε να θεωρήσουμε ότι ο κύκλος ξεκινάει με την είσοδο του 
αποξυγονωμένου αίματος από το σώμα στη καρδιά. 

Ο δεξιός κόλπος της καρδιάς δέχεται το αίμα από όλα τα μέρη του σώματος 
μέσω των μεγάλων φλεβών, το προωθεί στη δεξιά κοιλία και από εκεί στην 
πνευμονική κυκλοφορία με στόχο την οξυγόνωσή του. Στη συνέχεια, το πλούσιο σε 
οξυγόνο αίμα προωθείται από τους πνεύμονες στον αριστερό κόλπο και από εκεί 
στην αριστερή κοιλία. Η τελευταία αποτελεί το πιο «δυνατό» και σημαντικό τμήμα του 
μυοκαρδίου γιατί με τη συστολή της προωθεί το οξυγονωμένο πλέον αίμα σε όλο το 
σώμα μέσω της αορτής και των μεγάλων αρτηριών. Στην αορτή το αίμα έχει πίεση 
πέντε ή έξι φορές υψηλότερη από ότι στην πνευμονική αρτηρία. 

 
 
 

1.4 ΑΟΡΤΗ 
 

Η αορτή είναι η πρώτη και κυριότερη αρτηρία του σώματος. Αποτελεί το 
βασικό κορμό από όπου ξεκινούν όλες οι αρτηρίες της σωματικής ή μεγάλης 
κυκλοφορίας. Το οξυγονωμένο αίμα διοχετεύεται από την αριστερή κοιλία σε 
ολόκληρο τον οργανισμό διαμέσου της αορτής. 

Διαιρείται στα ακόλουθα τμήματα:  
 

· Ανιούσα αορτή 
· Αορτικό τόξο 
· Κατιούσα θωρακική αορτή  
· Κοιλιακή αορτή 
 

Η αορτή εκφύεται από το αρτηριακό στόμιο της αριστερής κοιλίας της καρδιάς. 
Χωρίζεται από την αριστερή κοιλία με τις βαλβίδες, με την βοήθεια των οποίων το 
αίμα, όταν σταλθεί από την καρδιά στην αορτή, δεν μπορεί να επιστρέψει πίσω. Μετά 
την έκφυσή της, η αορτή στρέφεται προς τα άνω. Το τμήμα αυτό λέγεται ανιούσα 
αορτή. Όταν φτάσει πίσω από το δεύτερο δεξιό πλευρικό χόνδρο, τότε κάμπτεται σε 
σχήμα τόξου. Το τμήμα αυτό λέγεται αορτικό τόξο. Μετά η αορτή κατέρχεται και 
κατευθύνεται προς τη μπροστινή επιφάνεια των σπονδύλων, οπότε αυτό το τμήμα 
λέγεται κατιούσα θωρακική αορτή. Τέλος, φτάνει στην κοιλιά.(κοιλιακή αορτή). 
(Εικόνα 1.2) 
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Εικόνα 1.2: Αορτή [22] 
 
 
 
 

1.5 ΑΡΤΗΡΙΑΚΗ ΠΙΕΣΗ 
 
Αρτηριακή πίεση είναι η δύναμη που προωθεί το αίμα σε όλους τους ιστούς 

του σώματος, εξασφαλίζοντας την συνεχή κυκλοφορία του αίματος. Η καρδιά μας 
είναι μια μικρή αλλά ισχυρή μυϊκή αντλία που κατά τη διάρκεια της ζωής μας «χτυπά» 
συνεχώς, δηλαδή συστέλλεται και διαστέλλεται, με ρυθμό περίπου 60-80 φορές το 
λεπτό, στέλνοντας 5 λίτρα αίματος το λεπτό σε όλο το σώμα. Η αρτηριακή πίεση 
καταγράφεται με δύο αριθμούς. Ο μεγαλύτερος αριθμός είναι η συστολική πίεση που 
είναι γνωστή ως «μεγάλη» πίεση, ο μικρότερος αριθμός είναι η διαστολική ή «μικρή» 
πίεση. Συστολική είναι η πίεση που ασκείται στις αρτηρίες όταν η καρδιά συσπάται 
για να προωθήσει το αίμα μέσω αρτηριών προς τα όργανα του σώματος και 
διαστολική όταν η καρδιά χαλαρώνει για να δεχθεί νέο αίμα. Η αρτηριακή πίεση 
εξαρτάται από τη δύναμη με την οποία η καρδιά ωθεί το αίμα και από την αντίσταση 
που προβάλλουν σε αυτή την προώθηση οι μικρές αρτηρίες. Στους νέους 
υπερτασικούς είναι συνήθως ισχυρότερη η δύναμη ώθησης του αίματος από την 
καρδιά, ενώ στους μεγαλύτερους είναι αυξημένη η αντίσταση των αρτηριών στη ροή 
του αίματος. 
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1.6 ΑΙΜΑ 
 

Το αίμα είναι το υγρό που κυκλοφορεί στο αγγειακό σύστημα των ανθρώπων 
και μεταφέρει χρήσιμα και απαραίτητα στοιχεία για τη φυσιολογική λειτουργία του 
οργανισμού μας. Αποτελεί το 7% του βάρους του ανθρώπινου σώματος. Το αίμα 
διασχίζει το ανθρώπινο σώμα με μέση ταχύτητα 2 χιλιόμετρα την ώρα, καλύπτοντας 
όλο το δίκτυο των αιμοφόρων αγγείων, των οποίων η επιφάνεια υπολογίζεται σε 
8.000 τετραγωνικά μέτρα. Με κάθε παλμό της η καρδιά διοχετεύει περίπου 70 
χιλιοστόλιτρα αίματος στις αρτηρίες, που ισοδυναμούν με περίπου 7.000 λίτρα 
ημερησίως ή περίπου 2,5 εκατομμύρια λίτρα το χρόνο. 

Το αίμα αποτελείται από κύτταρα(έμμορφα συστατικά) τα οποία αιωρούνται 
μέσα σε ένα υγρό, που ονομάζεται πλάσμα. Το πλάσμα αποτελεί το 55% του όγκου 
του αίματος. Αποτελείται κατά 91,5% από νερό, κατά 7% από πρωτεΐνες και κατά 
1,5% από άλλες ουσίες, όπως θρεπτικά συστατικά, ορμόνες, αναπνευστικά αέρια, 
ηλεκτρολύτες, βιταμίνες και άχρηστες αζωτούχες ουσίες 

Τα έμμορφα συστατικά του αίματος είναι τα ερυθρά αιμοσφαίρια, τα λευκά 
αιμοσφαίρια και τα αιμοπετάλια όπως μπορούμε να δούμε και στην εικόνα 1.3. 

 

 
 
 

Εικόνα 1.3: Σύσταση αίματος [23] 
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1.7 ΡΕΟΛΟΓΙΑ ΤΟΥ ΑΙΜΑΤΟΣ 
 

Το αίμα είναι μια περίπτωση πολυφασικού μίγματος. Το μίγμα αυτό όπως 
αναφέραμε και στην παράγραφο 1.6 αποτελείται από το πλάσμα, το οποίο είναι ένα 
νευτωνικό ρευστό, και από τρείς κυτταρικούς τύπους. Τα λευκά αιμοσφαίρια, τα 
ερυθρά αιμοσφαίρια και τα αιμοπετάλια. Η τιμή του ιξώδους του αίματος δεν είναι 
σταθερή αλλά μεταβάλλεται ανάλογα με το ρυθμό διάτμησης. Αυτό συμβαίνει εξαιτίας 
των συσσωματωμάτων που δημιουργούν τα ερυθρά αιμοσφαίρια σε χαμηλούς 
ρυθμούς διάτμησης. Όταν έχουμε αύξηση του ρυθμού διάτμησης, τα 
συσσωματώματα σταδιακά καταστρέφονται με αποτέλεσμα τη μείωση του ιξώδες 
προς μία οριακή τιμή( μ∞). Η συμπεριφορά αυτή του αίματος το κατατάσσει στα μη 
Νευτωνικά ρευστά. 

Στη επιστημονική ιατρική κοινότητα οι απόψεις για τον χαρακτηρισμό του 
αίματος ως Νευτωνικού ή μη Νευτωνικού ρευστού διίστανται. Αυτό συμβαίνει διότι 
πολλοί ερευνητές και επιστήμονες θεωρούν ότι το αίμα συμπεριφέρεται ως 
Νευτωνικό ρευστό [16-17] και αυτό οφείλεται στους υψηλούς ρυθμούς διάτμησης που 
επικρατούν στις μεγάλες αρτηρίες, όπως για παράδειγμα στην αορτή που είναι η 
μεγαλύτερη αρτηρία του καρδιαγγειακού συστήματος του ανθρώπου και η υπό 
μελέτη αρτηρία μας. Ωστόσο υπάρχουν και ερευνητές που πιστεύουν πως μια τέτοια 
θεώρηση είναι επισφαλή [18]. 

Υπό κανονικές συνθήκες και σε κατάσταση ηρεμίας, η ροή του αίματος μέσα 
σε μία αρτηρία είναι στρωτή. Η τριβή που υπάρχει μεταξύ ρευστού και ενδοθηλιακών 
κυττάρων δημιουργεί μία εφαπτομενική δύναμη που ασκείται από το ρευστό στην 
εσωτερική επιφάνεια της αρτηρίας και είναι γνωστή ως τοιχωματική διατμητική τάση 
(Wall Shear Stress,WSS). Το μέγεθος της τοιχωματικής διατμητικής τάσης εξαρτάται 
από το πόσο γρήγορα αυξάνεται η ταχύτητα του ρευστού ενώ η μεταβολή της 
ταχύτητας ονομάζεται ρυθμός διάτμησης(shear rate).[6]  
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ΚΕΦΑΛΑΙΟ 2: ΥΠΟΛΟΓΙΣΤΙΚΟ ΠΡΟΓΡΑΜΜΑ FLUENT 
 

  
 

2.1 ΘΕΩΡΗΤΙΚΗ ΑΝΑΛΥΣΗ 
 

Το Fluent είναι ένα υπολογιστικό πρόγραμμα που μοντελοποιεί ροές, 
φαινόμενα μεταφοράς και χημικές αντιδράσεις. Το Fluent δίνει στον χρήστη τη 
δυνατότητα να προσομοιώσει στον υπολογιστή τα πρακτικά σχεδιαστικά του 
προβλήματα για να τα αναλύσει και να τα λύσει. Το πακέτο ενσωματώνει σύγχρονες 
τεχνικές μοντελοποίησης και ένα πλατύ πεδίο φυσικών μοντέλων για προσομοίωση 
πολυάριθμων τύπων ροϊκών προβλημάτων. Το Fluent μπορεί να μοντελοποιήσει 
φυσικά φαινόμενα όπως, στρωτή ή τυρβώδη ροή, στρωτή ροή μη νευτωνικών 
ρευστών, ασυμπίεστη ή συμπιεστή ροή, σταθερή ή μεταβατική κατάσταση, 
δυσδιάστατη ή τρισδιάστατη γεωμετρία. 

Η σωστή μοντελοποίηση είναι μια διαδικασία επίπονη και απαιτεί προσοχή 
έτσι ώστε να μην παραλείψουμε βασικές παραμέτρους του προβλήματος. Είναι 
απαραίτητη η κριτική ικανότητα του χρήστη και η οργάνωση του προβλήματος σε 
ενότητες. Η μοντελοποίηση στο Fluent χωρίζεται στα παρακάτω βήματα: 
 
· Καθορισμός των στόχων της μοντελοποίησης ανάλογα με τα αποτελέσματα 
και την ακρίβεια που απαιτούνται 
· Επιλογή του υπολογιστικού πλέγματος, απομονώνοντας το κομμάτι εκείνο του 
συστήματος που μας ενδιαφέρει, και των οριακών συνθηκών 
· Σχεδιασμός του πλέγματος ανάλογα με την ακρίβεια που απαιτείται σε κάθε 
περιοχή 
· Επιλογή φυσικού μοντέλου ανάλογα με την ροή του ρευστού 
· Καθορισμός της διαδικασίας λύσης επιταχύνοντας την σύγκλιση, καθώς μας 
ενδιαφέρει μικρός υπολογιστικός χρόνος και χρησιμοποίηση μικρής υπολογιστικής 
ισχύος 

Οι διαφορικές εξισώσεις που διέπουν την ροή ενός ρευστού συνήθως δεν είναι 
αναλυτικές λύσεις, παρά μόνο για πολύ απλές περιπτώσεις. Ως εκ τούτου 
προκειμένου να αναλυθεί το ρευστό που ρέει, οι περιοχές ροής χωρίζονται σε 
μικρότερους υποτομείς που αποτελούνται από γεωμετρικά αρχέτυπα, όπως εξάεδρα 
(hexahedra) και τετράεδρα (tetrahedra) σε τρισδιάστατες γεωμετρίες (Εικόνα 2.1) 
που διέπουν εξισώσεις και επιλύονται μέσα σε κάθε ένα από αυτά τα τμήματα του 
τομέως. Πρέπει να ληφθεί μέριμνα ώστε να διασφαλιστεί η σωστή συνέχεια της 
λύσης στο σύνολο των κοινών διεπαφών μεταξύ των δύο υποτομέων, έτσι ώστε οι 
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προσεγγιστικές λύσεις μέσα σε διάφορα τμήματα να μπορούν να ενωθούν για να 
δώσουν μια πλήρη εικόνα της ροής ρευστού σε ολόκληρο τον τομέα. Κάθε ένα από 
αυτά τα τμήματα του τομέως είναι γνωστά ως στοιχεία ή κύτταρα ή κελιά και η 
συλλογή όλων των στοιχείων είναι γνωστό ως πλέγμα. Η διαδικασία της απόκτησης 
ενός κατάλληλου πλέγματος ονομάζεται δημιουργία πλέγματος και έχει θεωρηθεί από 
καιρό ένα εμπόδιο στη διαδικασία ανάλυσης, λόγω της έλλειψης μιας διαδικασίας 
πλήρους αυτόματης δημιουργίας πλέγματος. 

 To Fluent χρησιμοποιεί πεπερασμένα στοιχεία και υποστηρίζει και μη- 
δομημένα πλέγματα (unstructured) όλων των τύπων τα οποία είναι ένα σύνολο 
διακριτών πλεγμάτων που παράγουν εντός του χώρου τυχαίες αποστάσεις και δεν 
ακολουθούν κανένα ενιαίο πρότυπο και ως εκ τούτου το όνομα μη-δομημένο πλέγμα. 
 

 

 
 

Εικόνα 2.1: Γεωμετρικά αρχέτυπα 
 

 
 
 
 

2.2 ΜΑΘΗΜΑΤΙΚΗ ΠΡΟΣΕΓΓΙΣΗ 
 

Το Fluent για όλες τις ροές των ρευστών επιλύει διάφορες εξισώσεις. Επιλύει 
τις εξισώσεις διατήρησης της μάζας και διατήρησης της ορμής για όλα τα είδη των 
ροών και ανάλογα με τα δεδομένα του προβλήματος επιλύει και άλλες όπως την 
εξίσωση διατήρησης της ενέργειας αν πρόκειται για μεταφορά θερμότητας. Επίσης 
επιλύονται και άλλες εξισώσεις στην περίπτωση τυρβώδους ροής. Στην συνέχεια 
παρουσιάζονται περιληπτικά οι πιο βασικές εξισώσεις που επιλύει το υπολογιστικό 
πρόγραμμα Fluent για την επίλυση των προσομοιώσεων που πραγματοποιήσαμε. 
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2.2.1 Εξίσωση Διατήρησης της Μάζας  
 

Η διαφορική εξίσωση της διατήρησης της μάζας (απουσία πηγής ή 
καταβόθρας), η οποία επίσης λέγεται και εξίσωση συνέχειας και είναι έγκυρη για 
μόνιμη και μη μόνιμη ροή, καθώς και για συμπιεστά και ασυμπίεστα ρευστά: 
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rrrr  (2.1) 

 
Σε διανυσματικό συμβολισμό η (2.1) γράφεται: 
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¶
¶ V

t
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r  (2.2) 

 
Για μόνιμη ροή και συμπιεστά ρευστά: 
 

 0=×Ñ Vr   ή  (2.3α) 
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Για ασυμπίεστη (ρ=σταθερό) η (2.2) γίνεται: 
 

 0=×Ñ V  ή  (2.4α) 
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2.2.2 Εξίσωση Διατήρησης της Ορμής (Navier-Stokes) 
 
 

 ( ) ( ) ( ) Fgpuuu
t

rrrrr
++×Ñ+-Ñ=×Ñ+

¶
¶

rtrr  (2.5) 

 
 
Όπου:   
p: στατική πίεση 

t : τανυστής τάσης 
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grr : δύναμη λόγω βαρύτητας (ανά μονάδα όγκου) 

F
r

: εξωτερική δύναμη (ανά μονάδα όγκου) 
Η δύναμη 

ur
F  μπορεί να περιέχει και επιπλέον εξαρτώμενους παράγοντες ορισμένους 

από τον χρήστη. 
 

Ο τανυστής τάσης t  δίνεται από την παρακάτω σχέση: 
 

 ( ) úû
ù

êë
é ×Ñ-Ñ+Ñ= Iuuu T rrr

3
2

mt   (2.6) 

 
Όπου:  
μ: μοριακό ιξώδες 
Ι: μοναδιαίος τανυστής  
 
 
 

2.2.3 Ιξώδες ρευστών και διατμητική τάση 
 

Ιξώδες είναι το μέτρο των δυνάμεων συνάφειας μεταξύ των μορίων ενός 
ρευστού και καθορίζει το πόσο εύκολα ή δύσκολα αυτό ρέει. Το ιξώδες σχετίζεται με 
την διατμητική τάση, καθώς είναι η σταθερά αναλογίας της διατμητικής τάσης και του 
ρυθμού παραμόρφωσης σύμγωνα με τον 2ο νόμο του Νεύτωνα όπως εκφράζεται στα 
ρευστά. Στα ρευστά η διατμητική τάση ορίζεται : 
 

 

y
uy

u

¶
¶

=Û
¶
¶

×=
t

mmt (Pascal∙s)   (2.7) 

 
Η δύναμη ανά μονάδα επιφάνειας (shear stress) είναι ανάλογη της κλίσης ταχύτητας. 
 
 

 
y
u

¶
¶ = ρυθμός διάτμησης (shear rateg& )  

 
Τα ρευστά τα οποία υπακούν σε αυτόν τον νόμο (εξίσωση 2.7) ονομάζονται 

νευτώνεια ενώ τα υπόλοιπα ονομάζονται μη νευτώνεια. Εάν το ιξώδες είναι 
συνάρτηση της ταχύτητας του τότε η εξίσωση των διατμητικών τάσεων είναι μη 
γραμμική. Σε αυτή την περίπτωση το ρευστό ονομάζεται μη νευτώνειο. 

Στα νευτώνεια το ιξώδες είναι ανεξάρτητο του λόγου 
y
u

¶
¶  τότε το ιξώδες μ έχει 

σταθερή τιμή. Στα μη νευτώνεια ρευστά το ιξώδες δεν έχει σταθερή τιμή αλλά δίνεται 
από μία άλλη σχέση την οποία θα αναφέρουμε στην συνέχεια. 
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2.2.4 Μοντέλο Carreau 
 

To πιο σύνηθες μοντέλο και από τα πιο δημοφιλή, το οποίο χρησιμοποιείται 
για να περιγράψει το ιξώδες του αίματος το οποίο δεν έχει σταθερή τιμή, εάν 
θεωρηθεί μη νευτώνειο ρευστό, είναι το μοντέλο Carreau και περιγράφεται από την 
παρακάτω εξίσωση: 
 

 ( ) ( ) ( )[ ] 2
1

21
-

¥¥ ×+×-+=
n

glmmmgm o &&   (2.8) 
 
 
Όπου: 
λ: σταθερά χρόνου 
n: δείκτης δύναμης 
μ∞: ιξώδες σε άπειρο ρυθμό διάτμησης 
μο: ιξώδες σε μηδενικό ρυθμό διάτμησης 
 
 

 

2.2.5 Εξισώσεις παροχής  
 

Η παροχή όγκου Q που διαρρέει την αρτηρία δίνεται ύστερα από ολοκλήρωση 
της κατανομής ταχυτήτων στην διατομή S: 
 

 2

0
2= p= × ¾ ¾ ¾ ¾® = × × p × ×ò ò

r r RdS rdr

Ss

Q u nd S Q u r dr  (2.9) 

 
Αντίστοιχα η χρονικά μεταβαλλόμενη παροχή δίνεται από τον τύπο : 
 

 ( ) ÷
ø
ö

ç
è
æ=

T
tuRtQ m pp 22 sin2  (2.10) 

 
Η χρονικά μέση παροχή στην περίοδο είναι: 
 

 mm uRQ 2p=  (2.11)  
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2.2.6 Εξισώσεις ταχύτητας στη μόνιμη και μη μόνιμη ροή 
 

Σε μία μόνιμη ροή με παραβολικό προφίλ ταχύτητας, η ταχύτητα εισόδου σε 
αγωγό κυκλικής διατομής δίνεται από την παρακάτω σχέση: 
 

 ( )
2

22 1
æ öæ ö

= -ç ÷ç ÷ç ÷è øè ø
i

ru r u
R

  (2.12) 

 
 
Την μέγιστη τιμή της η ταχύτητα την έχει όταν r=0 και δίνεται από τον παρακάτω 
τύπο: 
 

 uu 2max =   (2.13) 
 
 
Όπου:  
ui: η ταχύτητα εισόδου 
u : η μέση ταχύτητα στην διατομή 
R: η ακτίνα της διατομής 
r: η μεταβλητή ακτίνα της διατομής που παίρνει τιμές από 0 έως R 
 
 
Όταν έχουμε μη μόνιμη ροή, η ταχύτητα εισόδου είναι: 
 

 ÷
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2

2

sin14  (2.14) 

 
Η σχέση (2.13) προέκυψε από την χρονικά μεταβαλλόμενη μέση ταχύτητα της 
οποίας ο τύπος είναι: 
 

 ÷
ø
ö

ç
è
æ=

T
tuu m p2sin2  (2.15) 

 
Όπου:  

mu : χρονικά μέση τιμή ταχύτητας στην περίοδο T 
T: περίοδος 
t: χρονική στιγμή 
 
 
 
 
 



 
 
 
 

ΚΕΦΑΛΑΙΟ 3: ΧΩΡΙΚΗ ΔΙΑΚΡΙΤΟΠΟΙΗΣΗ

3.1 ΓΕΝΙΚΑ 
 

Σε αυτό το κεφάλαιο θα πραγματοποιήσουμε όλες τις απαραίτητες 
προετοιμασίες της γεωμετρίας, δηλαδή την δημιουργία υπολογιστικού πλέγματος, με 
σκοπό την προσομοίωση του προβλήματος στην συνέχεια. Θα κάνουμε 
διακριτοποίηση στην αορτή. Δηλαδή ο όγκος που καταλαμβάνει το ρευστό, η αορτή, 
διακριτοποιείται σε ένα πεπερασμένο σύνολο από όγκους ελέγχου π
κελία (Εικόνα 3.1, 3.2). Οι μερικές διαφορικές εξισώσεις 
αλγεβρικών εξισώσεων και στην συνέχεια επιλύονται αριθμητικά για να 
υπολογίσουμε το πεδίο λύσης.  
 

Εικόνα 3.1: Διακριτοποίηση με πεπερασμένους όγκους ελέγχου σε ροή αίματος σε 
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ΚΕΦΑΛΑΙΟ 3: ΧΩΡΙΚΗ ΔΙΑΚΡΙΤΟΠΟΙΗΣΗ 
 
 
 

Σε αυτό το κεφάλαιο θα πραγματοποιήσουμε όλες τις απαραίτητες 
προετοιμασίες της γεωμετρίας, δηλαδή την δημιουργία υπολογιστικού πλέγματος, με 
σκοπό την προσομοίωση του προβλήματος στην συνέχεια. Θα κάνουμε 

Δηλαδή ο όγκος που καταλαμβάνει το ρευστό, η αορτή, 
διακριτοποιείται σε ένα πεπερασμένο σύνολο από όγκους ελέγχου που ονομάζονται 

). Οι μερικές διαφορικές εξισώσεις ανάγονται σε ένα σύστημα 
εξισώσεων και στην συνέχεια επιλύονται αριθμητικά για να 

 

 
Διακριτοποίηση με πεπερασμένους όγκους ελέγχου σε ροή αίματος σε 

αορτή 

Σε αυτό το κεφάλαιο θα πραγματοποιήσουμε όλες τις απαραίτητες 
προετοιμασίες της γεωμετρίας, δηλαδή την δημιουργία υπολογιστικού πλέγματος, με 
σκοπό την προσομοίωση του προβλήματος στην συνέχεια. Θα κάνουμε χωρική 

Δηλαδή ο όγκος που καταλαμβάνει το ρευστό, η αορτή, 
ου ονομάζονται 
ένα σύστημα 

εξισώσεων και στην συνέχεια επιλύονται αριθμητικά για να 

 

Διακριτοποίηση με πεπερασμένους όγκους ελέγχου σε ροή αίματος σε 
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Εικόνα 3.2: Πεπερασμένοι όγκοι ελέγχου(κελιά) στην είσοδο της αορτής 
 
 

 
Το σύνολο των πεπερασμένων όγκων ελέγχου (κελιά) που αποτελούν την 

γεωμετρία της αορτής και έχει διακριτοποιηθεί, λέγεται πλέγμα( mesh/grid). 
Η επιλογή του πλέγματος είναι πολύ σημαντική για την εξαγωγή των 

αποτελεσμάτων. Για να είμαστε πιο ακριβείς στα αποτελέσματα μας πρέπει το 
πλέγμα να έχει μεγάλο αριθμό πεπερασμένων όγκων ελέγχου (κελιά). 
Για αυτό τον λόγο θα πραγματοποιήσουμε διαδοχικές χωρικές διακριτοποιήσεις με 
διαφορετικές κλίμακες (από αδρότερη σε λεπτομερέστερη) και θα επιλέξουμε το 
πλέγμα με την καλύτερη ικανοποιητική ακρίβεια σε συνάρτηση με το αποδεκτό 
σφάλμα, έτσι ώστε να προχωρήσουμε με την επίλυση του προβλήματος. H 
γεωμετρία της αορτής ανακτήθηκε μέσω υπολογιστικής τομογραφίας [9] CT Scan 
(Computer Tomography Scan), όπου χρησιμοποιεί ακτίνες Χ για να κάνει 
λεπτομερείς εικόνες των δομών στο εσωτερικό του σώματος. 
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3.2 ΕΙΣΑΓΩΓΗ ΓΕΩΜΕΤΡΙΑΣ 
 

Για την δημιουργία του πλέγματος χρησιμοποιήθηκε η εφαρμογή του πακέτου 
ANSYS με την ονομασία ICEM CFD.Το ICEM CFD είναι ένα λογισμικό το οποίο έχει 
την δυνατότητα να δημιουργεί και να επεξεργάζεται υπολογιστικά πλέγματα. Ξεκινάμε 
κάνοντας εισαγωγή του αρχείου της γεωμετρίας. 
 
File→ Geometry→ Open Geometry→ Επιλογή αρχείου γεωμετρίας 
 

 
 

Εικόνα 3.3: Γεωμετρία της αορτής 
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3.3 ΔΗΜΙΟΥΡΓΙΑ ΥΠΟΛΟΓΙΣΤΙΚΟΥ ΠΛΕΓΜΑΤΟΣ 
 

Αφού έχουμε εισάγει την γεωμετρία στο ICEM, μπορούμε τώρα να 
δημιουργήσουμε το πλέγμα. Θα θέσουμε κάποιες παραμέτρους που αφορούν τα 
χαρακτηριστικά του πλέγματος. 
 
Mesh→ Global Mesh Setup→ Global Mesh Setup→ Global Mesh Size→ Apply 
 

 
 

Εικόνα 3.4: Ρυθμίσεις στο πλέγμα 
  

 
 

Στην συνέχεια θα επιλέξουμε το είδος του υπολογιστικού πλέγματος που 
επιθυμούμε να δημιουργήσουμε. Θα επιλέξουμε να δημιουργηθεί πλέγμα σε όλο τον 
όγκο της γεωμετρίας. 
 
Mesh→ Compute Mesh→ Volume Mesh→ Compute  
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Εικόνα 3.5: Τύπος πλέγματος 
 
 
 

Στην πρώτη περίπτωση επιλέξαμε να δημιουργήσουμε ένα πλέγμα το οποίο 
δεν έχει πιο πολλά κελιά σε κάποια περιοχή που μας ενδιαφέρει πιο πολύ, αλλά έχει 
μια κατανομή κελιών σε όλη την γεωμετρία του ισομερή. Η κλίμακα καθώς και το 
μέγιστο στοιχείο έχουν την τιμή 1. Επίσης έχουμε διαλέξει να αγνοήσουμε το πάχος 
του τοιχώματος καθώς δεν μας ενδιαφέρει αυτή η περίπτωση (Εικόνα 3.7). 
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 Θα κάνουμε τώρα την ίδια διαδικασία για να δημιουργήσουμε ένα άλλο 
πλέγμα με διαφορετικές παραμέτρους όμως, με σκοπό να συγκρίνουμε τα δύο 
πλέγματα και να διαλέξουμε το ακριβέστερο υπολογιστικό πλέγμα για να 
προχωρήσουμε με την επίλυση/προσομοίωση του προβλήματος. 
 
Mesh→ Global Mesh Setup→ Global Mesh Setup→ Global Mesh Size→ Apply 
(Εικόνα 3.6α) 
Mesh→ Global Mesh Setup→ Global Mesh Setup → Prism Meshing Parameters→ 
OK (Εικόνα 3.6β) 
Mesh→ Compute Mesh→ Volume Mesh→ Compute (Εικόνα 3.6γ) 
 

 
 

α)  β) 
 Εικόνα 3.6α: Ρύθμιση πλέγματος   Εικόνα 36β: Επιλογή επιπέδων 
 
 

Στην δεύτερη αυτή περίπτωση δημιουργίας υπολογιστικού πλέγματος 
διαφοροποιήσαμε αρκετά τις τιμές των διάφορων παραμέτρων του πλέγματος με 
σκοπό να δούμε αν υπάρχει μεγάλη διαφορά ανάμεσα στα 2 πλέγματα που 
δημιουργήσαμε. Μικρύναμε την κλίμακα, ωστόσο αυξήσαμε την τιμή του μέγιστου 
στοιχείου και επίσης μειώσαμε αισθητά τα στοιχειά ανάμεσα στα κενά. Η πιο 
σημαντική ωστόσο αλλαγή είναι ότι απομονώσαμε το κομμάτι εκείνο της γεωμετρίας 
που μας ενδιαφέρει περισσότερο καθώς εκεί θέλουμε μεγαλύτερη ακρίβεια. 
Δημιουργήσαμε λοιπόν 5 επίπεδα/στρώματα (layers) κοντά στα τοιχώματα διότι εκεί 
μας ενδιαφέρει πιο πολύ να δούμε τις τιμές που παίρνουν τα διάφορα μεγέθη που θα 
μελετήσουμε.(Εικόνα 3.8) 
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Εικόνα 3.6γ: Επιλογή τύπου πλέγματος 
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Εικόνα 3.7: Διαμορφωμένο υπολογιστικό πλέγμα 
 

 
 

Εικόνα 3.8: Διαμορφωμένο υπολογιστικό πλέγμα με οριακά στρώματα  
 
 



3.4 ΕΠΙΛΟΓΗ ΥΠΟΛΟΓΙΣΤΙΚΟΥ ΠΛΕΓΜΑΤΟΣ
 

Αφού ολοκληρώθηκαν οι δύο περιπτώσεις χωρικών διακριτοποιήσεων με 
διαφορετικές παραμέτρους, είμαστε σε θέση πλέον να συγκρίνουμε τα δύο 
υπολογιστικά πλέγματα που δημιουργήσαμε και να επιλέξουμε το καλύτερο πλέγμα.
 

Εικόνα 3.9: Πληροφορίες πλέγματος 1
 
 
 

Εικόνα 3.10: Πληροφορίες πλέγματος 2
 

Συγκρίνοντας τα αποτελέσματα των εικόνων 3.7 και 3.8 βγαίνει το 
συμπέρασμα πως το υπολογιστικό πλέγμα της δεύτερης περίπτωσης είναι 
βέλτιστο διότι αποτελείται από μεγαλύτερο αριθμό πεπερασμένων όγκων έλεγχου
(κελιά). Επίσης σημαντικό είναι και το γεγονός πως έχουμε εστιάσει στην περιοχή 
γύρω από το τοίχωμα, δημιουργώντας 
μεγαλύτερη ακρίβεια στο κομμάτι της γεωμετρίας που μας ενδιαφέρει περισσότερο
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ΕΠΙΛΟΓΗ ΥΠΟΛΟΓΙΣΤΙΚΟΥ ΠΛΕΓΜΑΤΟΣ 

Αφού ολοκληρώθηκαν οι δύο περιπτώσεις χωρικών διακριτοποιήσεων με 
διαφορετικές παραμέτρους, είμαστε σε θέση πλέον να συγκρίνουμε τα δύο 

πλέγματα που δημιουργήσαμε και να επιλέξουμε το καλύτερο πλέγμα.

 
 

Πληροφορίες πλέγματος 1ης περίπτωσης 

 
 

Πληροφορίες πλέγματος 2ης περίπτωσης 

Συγκρίνοντας τα αποτελέσματα των εικόνων 3.7 και 3.8 βγαίνει το 
συμπέρασμα πως το υπολογιστικό πλέγμα της δεύτερης περίπτωσης είναι 

διότι αποτελείται από μεγαλύτερο αριθμό πεπερασμένων όγκων έλεγχου
(κελιά). Επίσης σημαντικό είναι και το γεγονός πως έχουμε εστιάσει στην περιοχή 
γύρω από το τοίχωμα, δημιουργώντας layers, και έτσι μπορούμε να έχουμε 
μεγαλύτερη ακρίβεια στο κομμάτι της γεωμετρίας που μας ενδιαφέρει περισσότερο

Αφού ολοκληρώθηκαν οι δύο περιπτώσεις χωρικών διακριτοποιήσεων με 
διαφορετικές παραμέτρους, είμαστε σε θέση πλέον να συγκρίνουμε τα δύο 

πλέγματα που δημιουργήσαμε και να επιλέξουμε το καλύτερο πλέγμα. 

Συγκρίνοντας τα αποτελέσματα των εικόνων 3.7 και 3.8 βγαίνει το 
συμπέρασμα πως το υπολογιστικό πλέγμα της δεύτερης περίπτωσης είναι το 

διότι αποτελείται από μεγαλύτερο αριθμό πεπερασμένων όγκων έλεγχου 
(κελιά). Επίσης σημαντικό είναι και το γεγονός πως έχουμε εστιάσει στην περιοχή 

και έτσι μπορούμε να έχουμε 
μεγαλύτερη ακρίβεια στο κομμάτι της γεωμετρίας που μας ενδιαφέρει περισσότερο. 
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3.5 ΠΡΟΕΠΙΛΟΓΗ ΛΥΤΗ 
 

Σε αυτό το στάδιο, το πλέγμα μετατρέπεται σε κατάλληλη μορφή έτσι ώστε να 
εισαχθεί στο λογισμικό ANSYS Fluent, με το οποίο θα γίνει η προσομοίωση. 
 
Output→ Select Solver→ Solver Setup→ Output Solver→ Fluent_V6→ 
Common Structural Solver→ ANSYS→ Apply 
 

 
 

Εικόνα 3.11: Επιλογή Λύτη 

3.6 ΔΗΜΙΟΥΡΓΙΑ ΚΑΙ ΑΠΟΘΗΚΕΥΣΗ ΑΡΧΕΙΟΥ FLUENT.MSH 
 
Output→ Write Input 
 

 
 

Εικόνα 3.12: Δημιουργία msh αρχείου 
Με αυτόν τον τρόπο δημιουργούμε και αποθηκεύουμε στην διεύθυνση που 

φαίνεται στο output file ένα αρχείο, με όνομα fluent.msh, το οποίο θα μπορούμε να το 
εισάγουμε στο fluent και να αρχίσουμε την προσομοίωση. 
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ΚΕΦΑΛΑΙΟ 4: ΠΡΟΣΟΜΟΙΩΣΗ ΠΑΛΜΙΚΗΣ ΡΟΗΣ ΑΙΜΑΤΟΣ 
ΣΕ ΠΡΟΤΥΠΗ ΑΡΤΗΡΙΑ 

 
 
 
 

Στο κεφάλαιο αυτό θα προσομοιώσουμε παλμική ροή αίματος σε αορτή για 
δύο περιπτώσεις. Στην μια περίπτωση θα θεωρήσουμε το αίμα μη νευτωνικό ρευστό 
και στην άλλη περίπτωση θα το θεωρήσουμε νευτωνικό. Το αίμα είναι αυστηρά μη 
νευτωνικό ρευστό ωστόσο όπως αναφέραμε και σε προηγούμενο κεφάλαιο, 
σύμφωνα με την βιβλιογραφία πολλοί ερευνητές το θεωρούν νευτωνικό ρευστό λόγω 
των υψηλών ρυθμών διάτμησης που επικρατούν στις μεγάλες αρτηρίες [16-17]. Θα 
έχει μεγάλο ενδιαφέρον να δούμε τι συμπεράσματα θα βγάλουμε από τις δύο 
προσομοιώσεις διότι η αρτηρία που μελετάμε είναι η μεγαλύτερη αρτηρία του 
σώματος. 
 
 
 

4.1 ΠΡΟΣΟΜΟΙΩΣΗ ΠΑΛΜΙΚΗΣ ΡΟΗΣ ΣΕ ΜΗ ΝΕΥΤΩΝΙΚΟ ΡΕΥΣΤΟ 
 

4.1.1 Παλμική ροή 
 

Για να προσομοιώσουμε παλμική ροή στο Fluent πρέπει να δημιουργήσουμε 
ένα αρχείο το οποίο να περιέχει τον κώδικα γραμμένο σε γλώσσα προγραμματισμού 
(C++) ο οποίος θα ορίζει την χρονικά μεταβαλλόμενη πίεση. 
Θα προσεγγίσουμε την πίεση στην είσοδο της αορτής με μια ημιτονοειδής 
συνάρτηση, όπου η κυκλική συχνότητα θα αντιστοιχεί στους σφυγμούς ενός υγιή 
ατόμου και το πλάτος της συνάρτησης θα είναι η τιμή της συστολικής πίεσης. 

Οι σφυγμοί που θα βάλουμε στην συνάρτηση θα είναι 75 παλμοί και η τιμή της 
συστολικής πίεσης θα είναι 120 mm Hg. Η εξίσωση που θα χρησιμοποιήσουμε θα 
είναι η εξής: 
 

P(t)=Po+15996*sin(7.85*t) 
 
Όπου το Po λαμβάνεται από τα πειραματικά νεφρικά στοιχεία από το Yim et al.[19] 
και η τιμή 15996Pa αντιστοιχεί σε 120mmHg. Η κυκλική συχνότητα ω προέκυψε ως 
εξής: 
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ω=2πf = 2π (75/60) @ 7.85 rad/s 
 
Ο κώδικας της παλμικής ροής που χρησιμοποιήσαμε είναι ο εξής:  
 
 
#include “udf.h” 
DEFINE_PROFILE(pres,thread,position) 
{ 
face_t f; 
real t=CURRENT_TIME; 
begin_f_loop(f,thread) 
{ 
F_PROFILE(f,thread,position)=17300.0+15996.0*sin(7.85*t); 
} 
end_f_loop(f,thread) 
} 
 
 
 

4.1.2 Έναρξη υπολογιστικού προγράμματος Fluent 
 

Επιλέγουμε το είδος του προβλήματος που θα λυθεί.(3D,τρισδιάστατο) 
 

 
 

Εικόνα 4.1: Έναρξη Fluent 
 

4.1.3 Εισαγωγή κώδικα παλμικής ροής 
 

Ζητάμε από το πρόγραμμα να διαβάσει τον κώδικα 
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Define→ User-Defined→ Functions→ Interpreted UDFs→ Επιλογή του αρχείου με 
τον κώδικα → Interpret 

 
 

Εικόνα 4.2: Εισαγωγή συνάρτησης 
 

Εφόσον διάβασε τον κώδικα το Fluent μπορούμε να συνεχίσουμε την 
διαδικασία προσομοίωση. 
 
 
 

4.1.4 Εισαγωγή γεωμετρίας και πλέγματος στο Fluent 
 

Αφού έχουμε ολοκληρώσει την διαδικασία δημιουργίας υπολογιστικού 
πλέγματος στην γεωμετρίας μας από το κεφάλαιο 3 μπορούμε τώρα να εισάγουμε 
την γεωμετρία και να προχωρήσουμε την διαδικασία προσομοίωσης. 
 
File→ Read→ Mesh 
 

 
 

Εικόνα 4.3: Εισαγωγή πλέγματος στο Fluent 
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4.1.5 Έλεγχος επιτυχούς εισαγωγής πλέγματος 
 

Θα πραγματοποιήσουμε έναν έλεγχο για να δούμε ότι η εισαγωγή του 
πλέγματος είναι επιτυχής 
 
Mesh→ Info→ Size 
 

 
 

Εικόνα 4.4: Έλεγχος πλέγματος 
 

Η εισαγωγή του πλέγματος ήταν επιτυχής και το Fluent μας εμφανίζει κάποια 
στοιχεία της γεωμετρίας.(Εικόνα 4.4) 
 
 
 

4.1.6 Καθορισμός κλίμακας 
 

Θα καθοριστούν οι μονάδες του πλέγματος:  
 

 
 

Εικόνα 4.5: Κλίμακα πλέγματος 
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Στην εικόνα 4.5 βλέπουμε τις οριακές διαστάσεις του γεωμετρικού μας 
μοντέλου σε χιλιοστά 

4.1.7 Έλεγχος πλέγματος 
 

Αφού έχουμε επιλέξει και τις μονάδες που θέλουμε, μπορούμε τώρα να 
ελέγξουμε το πλέγμα και να δούμε κάποια άλλα στατιστικά στοιχεία του πλέγματος. 
 
General→ Mesh→ Check 
 

 
 

Εικόνα 4.6: Στατιστικά στοιχεία γεωμετρίας 
 
 
 

4.1.8 Ορισμός παραμέτρων λύτη Fluent 
 

Στο βήμα αυτό θα διαλέξουμε τον τύπο του λύτη για την προσομοίωση της 
γεωμετρίας μας. Το Fluent έχει δύο τύπους λυτών. Ο ένας ονομάζεται Pressure-
Based και επιλύει χρησιμοποιώντας αλγορίθμους με βάση την πίεση και ο δεύτερος 
ονομάζεται Density-Based και χρησιμοποιεί αλγορίθμους με βάση την πυκνότητα. Ο 
τύπος που θα χρησιμοποιήσουμε εμείς θα είναι ο Pressure-Based διότι προτιμάται 
σε περιπτώσεις επίλυσης ρευστοδυναμικών μοντέλων λόγω της ευελιξίας που 
διαθέτει. Επίσης θα επιλέξουμε στην παράμετρο του time την επιλογή transient 
(παροδικός) και αυτό διότι θέλουμε να μελετήσουμε παλμική ροή και όχι σταθερή 
ροή. 
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Εικόνα 4.7: Ορισμός παραμέτρων 
 
 
 

4.1.9 Ορισμός μοντέλου ροής 
 

Θα επιλέξουμε στα μοντέλα προσομοίωσης αυτό της στρωτής ροής (Viscous 
Laminar) 
 
Models→ Viscous Laminar→ Edit→ Ok 
 

 
 

Εικόνα 4.8: Μοντέλα ροής 
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Εικόνα 4.9: Επιλογή μοντέλου 
 
 

4.1.10 Καθορισμός ιδιοτήτων ρευστού και αγωγού 
 

Θέτουμε τις ιδιότητες του ρευστού που κινείται μέσα στην αρτηρία, δηλαδή του 
αίματος. Αρχικά θα το θεωρήσουμε μη νευτώνειο ρευστό. 
 
Define→ Materials 
 

 
 

Εικόνα 4.10: Εισαγωγή ιδιοτήτων αίματος 
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Η επιλογή της τιμής της πυκνότητας του αίματος έγινε με βάση το βιβλίο των 
Cutnell John & Johnson Kenneth [11]. 

Όσον αφορά την τιμή του ιξώδους του αίματος, επειδή το θεωρήσαμε μη 
νευτώνειο ρευστό θα χρησιμοποιήσουμε την πιο δημοφιλή προσέγγιση 
χρησιμοποιώντας το μοντέλο Carreau το οποίο διέπεται από την εξίσωση (2.8) . 

Οι τιμές που χρησιμοποίησα για τις παραμέτρους της εξίσωσης αναφέρονται 
στην δημοσίευση των Mark W. Siebert and Petru S. Fodor [10]. 
 
 

 
 

Εικόνα 4.11: Μοντέλο Carreau 
 

 
Στην συγκεκριμένη προσομοίωση μελετάται μόνο το εσωτερικό της αρτηρίας 

και όχι το τοίχωμα, καθώς δεν λαμβάνονται υπόψη θερμικές και μηχανικές ιδιότητες 
όπως ελαστικότητα. Δηλαδή προσεγγίζουμε το τοίχωμα ως απαραμόρφωτο, 
αδιαπέρατο και ακίνητο. Έτσι δεν επηρεάζει τα αποτελέσματα η επιλογή του υλικού 
του τοιχώματος. Έτσι επιλέγουμε την προεπιλογή του Fluent, δηλαδή το αλουμίνιο. 
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Εικόνα 4.12: Δημιουργία υλικού αγγείου 
 

 

4.1.11 Συνοριακές συνθήκες 
 

Θα ορίσουμε τις συνοριακές συνθήκες κάθε ζώνης της γεωμετρία μας. Έχουμε 
τέσσερις ζώνες οι οποίες είναι οι παρακάτω:  
 

· Aorta (τοίχωμα της αορτής) 
· Inlet (Είσοδος ρευστού) 
· Ιnt_created_material_6 (Εσωτερική περιοχή ροής ρευστού) 
· Outlet (Έξοδος) 

 

 
 

Εικόνα 4.13: Συνοριακές Συνθήκες 
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4.1.12 Ορισμός συνοριακής συνθήκης εισόδου-inlet 
 
Inlet→ Type→ Pressure Inlet→ Οκ 
 
Στην συνέχεια επιλέγουμε το Edit για να ορίσουμε επιπλέον παραμέτρους. 
 

 
 

Εικόνα 4.14: Επιλογή ζώνης 
 
 
 

 
 

Εικόνα 4.15: Εισαγωγή συνάρτησης 
 

Όπως βλέπουμε στην εικόνα 4.15 έχουμε εισάγει την συνάρτηση της παλμικής 
ροής και το fluent θα χρησιμοποιεί για την ολική πίεση αυτή την συνάρτηση. 
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Στην εικόνα 4.16 βλέπουμε την πίεση η οποία επικρατεί στο εσωτερικό της 
αορτής. 

 

 
 

Εικόνα 4.16: Πίεση λειτουργίας στο εσωτερικό της αορτής 
 

4.1.13 Ορισμός συνοριακής συνθήκης εξόδου-outlet 
 

Σε αυτό το βήμα θα ορίσουμε την οριακή συνθήκη στην έξοδο του ρευστού. 
Οπότε έχουμε: 
 
Outlet→ Type→ Pressure Outlet→ Ok 
 
 

 
 

Εικόνα 4.17: Επιλογή ζώνης της γεωμετρίας 
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Εικόνα 4.18: Σχετική πίεση εξόδου 

 
 
 

4.1.14 Ορισμός συνοριακής συνθήκης τοιχώματος(aorta) 
 

Θα επιλέξουμε σταθερό τοίχωμα επειδή δεν κινείται σε κάποιον άξονα και 
χωρίς ολίσθηση. 
 
Aorta→ Type→ Wall→ Momentum→ Οκ 
 

 
 

Εικόνα 4.19: Εισαγωγή ιδιοτήτων τοιχώματος 
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4.1.15 Ορισμός μεθοδολογίας επίλυσης 
 
Επιλέγουμε την μέθοδο της λύσης του προβλήματος και τον βαθμό 

διακριτοποίησης και ακρίβειας όπου θα επιλύσει τις εξισώσεις ο λύτης. 
 

 
 

Εικόνα 4.20: Μέθοδος επίλυσης 
 
 

Στην συνέχεια επιλέγουμε τις προεπιλογές του fluent για τις παραμέτρους 
λύσης του προβλήματος. Αυτοί οι παράμετροι ονομάζονται under relaxation factors 
και χρησιμοποιούνται για να επιλύονται εξισώσεις.(Εικόνα 4.21) 
 

 
 

Εικόνα 4.21: Παράμετροι λύτη 
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4.1.16 Κριτήριο σύγκλισης 
 

Επιλέγουμε την ακρίβεια σύγκλισης που επιθυμούμαι. Εμείς επιλέξαμε 
σύγκλιση των εξισώσεων της τάξης του 10-4 
 
Solution→ Monitors→ Residuals-Print, Plot→ Edit→ Ok 
 

 
 

Εικόνα 4.22: Κριτήριο Σύγκλισης 
 
 
 

4.1.17 Αρχικοποίηση λύτη 
 

Καθορίζονται οι αρχικές συνθήκες του προβλήματος. Επιλέγουμε η επίλυση να 
γίνεται από την είσοδο της αρτηρίας μας. 
 
Solution Initialization→ Compute from→ Inlet→ Initialize 
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Εικόνα 4.23: Αρχικοποίηση του Λύτη 
 
 
 

4.1.18 Επίλυση 
 

Φτάνοντας ένα βήμα πριν ξεκινήσει η διαδικασία της προσομοίωσης πρέπει 
να ορίσουμε έναν αριθμό υπολογιστικών επαναλήψεων ο οποίος είναι πολύ 
σημαντικός για την διαδικασία της προσομοίωσης. 
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Εικόνα 4.24: Έναρξη των υπολογισμών 
 
 

Θα αναλύσουμε κάποιες παραμέτρους της εικόνας 4.24: 
 

· Time step Size: ορισμός διάρκειας σε δευτερόλεπτα του χρονικού βήματος 
προσομοίωσης 

· Number of time steps: ορισμός του αριθμού των χρονικών βημάτων 
· Max iterations/time step: ορισμός μέγιστου αριθμού επαναλήψεων ανά 

χρονικό βήμα 
 
Η επιλογή των τιμών στην εικόνα 4.24 έγινε μετά από μια διαδικασία 

πραγματοποιήσης μερικών προσομοιώσεων μέχρι να βρούμε την λύση η οποία θα 
συνέκλινε και θα είχε την μεγαλύτερη ακρίβεια. 

Στην αρχή επιλέξαμε να προσομοιώσουμε με χρονικό βήμα 0.02 sec και 
αριθμό χρονικών βημάτων 80. Στην συνέχεια προσομοιώσαμε με χρονικό βήμα 0.01 
sec και αριθμό χρονικών βημάτων 160 και συγκρίναμε τα αποτελέσματα των δύο 
προσομοιώσεων. Είδαμε πως υπήρχαν κάποιες διαφορές στα αποτελέσματα και έτσι 
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απορρίψαμε την περίπτωση χρησιμοποίησης της χρονικής διακριτοποίησης της 
πρώτης προσομοίωσης. Τέλος πραγματοποιήσαμε άλλη μια προσομοίωση με 
χρονικό βήμα 0.005 και αριθμό χρονικών βημάτων 320. Τα αποτελέσματα τα οποία 
πρόεκυψαν από την σύγκριση της δεύτερης προσομοίωσης και αυτής ήταν τα ίδια. 
Έτσι αποφασίσαμε να χρησιμοποιήσουμε τις τιμές της δεύτερης προσομοίωσης για 
την χρονική διακριτοποίηση. Επιλέξαμε την δεύτερη και όχι την τρίτη διότι, ναι μεν 
είχαμε την ίδια ακρίβεια αλλά ο υπολογιστικός χρόνος της τρίτης προσομοίωσης ήταν 
μεγαλύτερος από ότι της δεύτερης. 

Άρα ορίσαμε την παράμετρο time step size να ισούται με 0.01s και ο αριθμός 
των χρονικών βημάτων να είναι 160. Αυτό σημαίνει πως η προσομοίωση μας γίνεται 
για 1.6 δευτερόλεπτα, χρόνος ο οποίος αντιπροσωπεύει την διάρκεια δύο παλμών. 
Οι επαναλήψεις που θέσαμε ήταν 100. Ήταν αρκετές για να έχουμε μια ικανοποιητική 
λύση . 

 
 
 

Αφού λοιπόν ορίσουμε τις παραμέτρους κάνουμε και έναν έλεγχο για τυχόν 
σφάλματα. 
 
Solution→ Run Solution→ Check case 
 
 

 
 

Εικόνα 4.25: Έλεγχος υπόθεσης(case) 
 
 

Στην συνέχεια παραθέτουμε κάποια στατιστικά στοιχεία κατά την διάρκεια της 
επίλυσης του προβλήματος. 
 



 
Εικόνα 4.2

Η λύση μας φαίνεται από τα στατιστικά πως συγκλίνει ωστόσο πρέπει να 
ελέγξουμε την παροχή μάζας μέσα στο πεδίο μας για να σιγουρευτούμε πως 
διατηρείται η μάζα. 
 
Report→ Fluxes 
 
 
 

Εικόνα 4.2
 
 
 

Ολοκληρώσαμε λοιπόν τη προσομοίωση μας για την πρώτη περίπτωση, όπου 
θεωρούμε το αίμα μη νευτωνικό ρευστό. Αυτό σημαίνει πως το ιξώδες του αλλάζει 
τιμές και δεν έχει κάποια σταθερή τιμή. Η εξίσωση που χρησιμοποιήσαμε για την 
περιγραφή του ιξώδες ήταν του μοντέλου 
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Εικόνα 4.26: Στατιστικά στοιχεία λύσης 
 
 
 

Η λύση μας φαίνεται από τα στατιστικά πως συγκλίνει ωστόσο πρέπει να 
ελέγξουμε την παροχή μάζας μέσα στο πεδίο μας για να σιγουρευτούμε πως 

 
Εικόνα 4.27: Έλεγχος μάζας του ρευστού  

Ολοκληρώσαμε λοιπόν τη προσομοίωση μας για την πρώτη περίπτωση, όπου 
το αίμα μη νευτωνικό ρευστό. Αυτό σημαίνει πως το ιξώδες του αλλάζει 

τιμές και δεν έχει κάποια σταθερή τιμή. Η εξίσωση που χρησιμοποιήσαμε για την 
περιγραφή του ιξώδες ήταν του μοντέλου Carreau, ενός μοντέλου το οποίο 

 

Η λύση μας φαίνεται από τα στατιστικά πως συγκλίνει ωστόσο πρέπει να 
ελέγξουμε την παροχή μάζας μέσα στο πεδίο μας για να σιγουρευτούμε πως 

 

Ολοκληρώσαμε λοιπόν τη προσομοίωση μας για την πρώτη περίπτωση, όπου 
το αίμα μη νευτωνικό ρευστό. Αυτό σημαίνει πως το ιξώδες του αλλάζει 

τιμές και δεν έχει κάποια σταθερή τιμή. Η εξίσωση που χρησιμοποιήσαμε για την 
ενός μοντέλου το οποίο 
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χρησιμοποιείται πολύ συχνά για να περιγράψει το ιξώδες του μη νευτωνικού 
ρευστού, του αίματος. 

Στην συνέχεια θα κάνουμε άλλη μια προσομοίωση θεωρώντας αυτή την φορά 
το αίμα νευτωνικό ρευστό και θα έχει μεγάλο ενδιαφέρον να δούμε τα αποτελέσματα 
που θα εξάγουμε από τις δύο αυτές προσομοιώσεις. Επίσης σημαντικό στοιχείο είναι 
ότι το αίμα αποτελείται κατά 55% περίπου από το πλάσμα το οποίο είναι ένα 
νευτωνικό ρευστό. 
 
 
 

4.2 ΠΡΟΣΟΜΟΙΩΣΗ ΠΑΛΜΙΚΗΣ ΡΟΗΣ ΑΙΜΑΤΟΣ ΣΕ ΝΕΥΤΩΝΙΚΟ ΡΕΥΣΤΟ  
 
 

Η διαδικασία προσομοίωσης παλμικής ροής σε νευτωνικό ρευστό έχει 
ακριβώς τα ίδια βήματα με την προσομοίωση που πραγματοποιήσαμε στην 
παράγραφο 4.1 και διαφέρει μόνο στον καθορισμό των ιδιοτήτων του ρευστού καθώς 
το ιξώδες ενός νευτωνικού ρευστού έχει σταθερή τιμή. 
Περιληπτικά τα βήματα προσομοίωσης είναι τα ακόλουθα:  
 
 
· Εισαγωγή συνάρτησης παλμικής ροής 
· Εισαγωγή της γεωμετρίας και του πλέγματος στο Fluent 
· Έλεγχος του πλέγματος 
· Ορισμός μοντέλου 
· Καθορισμός ιδιοτήτων του ρευστού 
· Ορισμός των συνοριακών συνθηκών που επικρατούν στην αρτηρία 
· Ορισμός μεθόδου επίλυσης του προβλήματος 
· Επίλυση του προβλήματος της παλμικής ροής αίματος 
 
 
Τα μόνο βήμα που θα παρουσιάσω είναι ο καθορισμός των ιδιοτήτων των ρευστών 
καθώς μόνο αυτό είναι διαφορετικό σε σχέση με την προσομοίωση της παραγράφου 
4.1. 
 
Define→ Materials 
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Εικόνα 4.28: Καθορισμός ιδιοτήτων 
 

Θεωρώντας το αίμα νευτωνικό ρευστό, έχει πλέον μια σταθερή (constant) τιμή 
ιξώδους. Η τιμή την οποία του όρισα είναι 0.0035 kg/(m∙s), η οποία αναφέρεται στην 
δημοσίευση των Mark W. Siebert and Petrus S. Fodor [10]. 
 
Θα παρουσιάσω μερικά στοιχειά της προσομοίωσης που πραγματοποίησα. 
 
· Στην εικόνα 4.29 μπορούμε να διακρίνουμε ένα στιγμιότυπο κατά την διάρκεια 
των υπολογισμών που πραγματοποιεί το Fluent. Βλέπουμε πως το γράφημα έχει 
αρχίσει να λαμβάνει μια παλμική μορφή κατά την διάρκεια των υπολογισμών. 
 
 



Εικόνα 4.2

 
· Στην εικόνα 4.30 βλέπουμε κάποια στατιστικά στοιχεία της λύσης του 
προβλήματος 
 

 
Εικόνα 4.

 

45 
 

 
Εικόνα 4.29: Στιγμιότυπο υπολογισμών  

 

βλέπουμε κάποια στατιστικά στοιχεία της λύσης του 

Εικόνα 4.30: Στατιστικά στοιχεία 
 

 

βλέπουμε κάποια στατιστικά στοιχεία της λύσης του 
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· Βλέπουμε πως η λύση μας συγκλίνει ωστόσο πρέπει να γίνει έλεγχος στην 
παροχή μάζας για να δούμε αν υπάρχει διατήρηση της μάζας.(Εικόνα 4.31) 
 
 

 
 

Εικόνα 4.31: Έλεγχος αναφοράς ροών 
 
 
 

Έχοντας ολοκληρώσει τις προσομοιώσεις και για τις δύο περιπτώσεις που μας 
απασχόλησαν είμαστε σε θέση να αναλύσουμε και να συγκρίνουμε τα αποτελέσματα 
που έχουν εξαχθεί. 
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ΚΕΦΑΛΑΙΟ 5: ΑΠΟΤΕΛΕΣΜΑΤΑ ΠΡΟΣΟΜΟΙΩΣΕΩΝ 
 
 
 

Εφόσον ολοκληρώσαμε την διαδικασία των προσομοιώσεων είμαστε σε θέση 
να αναλύσουμε και να συγκρίνουμε τα διάφορα μεγέθη που επιθυμούμε για τις δύο 
περιπτώσεις μας. Στην πρώτη περίπτωση τα αποτελέσματα προέκυψαν θεωρώντας 
το αίμα μη νευτώνειο ρευστό. Άρα το ιξώδες του αίματος δεν είναι σταθερό αλλά 
μεταβάλλεται ανάλογα με το ρυθμό διάτμησης. Οπότε το προσεγγίσαμε 
χρησιμοποιώντας την εξίσωση από το μοντέλο Carreau το οποίο περιγράφει την 
σχέση ιξώδους και ρυθμού διάτμησης για το μη νευτωνικό αίμα. Προσομοιώσαμε με 
χρονικό βήμα 0.01 δευτερόλεπτα και αριθμό χρονικών βημάτων ίσο με 160. Άρα το 
Fluent προσομοίωσε και υπολόγισε την ροή στην αορτή για 1.6 δευτερόλεπτα με 
βήμα 0.01 δευτερόλεπτα. Τα 1.6 δευτερόλεπτα αντιστοιχούν σε 2 παλμούς. Για κάθε 
0.01 δευτερόλεπτο το υπολογιστικό πρόγραμμα Fluent πραγματοποιούσε 
επαναληπτικούς υπολογισμούς, υπολογίζοντας τις ροϊκές παραμέτρους. Στην 
δεύτερη περίπτωση χρησιμοποίησα τα ίδια χρονικά βήματα αλλά θεωρώντας πλέον 
το αίμα νευτωνικό ρευστό έπρεπε να αλλάξω την τιμή του ιξώδους του και να την 
αντικαταστήσω με μία σταθερή τιμή. 

Για την παρουσίαση των αποτελεσμάτων και των διαγραμμάτων 
χρησιμοποιήσαμε το Fluent αλλά και το πρόγραμμα CFD Post. 
 
 

5.1 ΔΙΑΝΥΣΜΑΤΑ ΤΑΧΥΤΗΤΑΣ 
 

Στις εικόνες 5.1 και 5.2 παρουσιάζονται τα διανύσματα ταχύτητας και για τις 
δύο περιπτώσεις προσομοίωσης. Το ρευστό εισέρχεται από την δεξιά μεριά όπου 
είναι η είσοδος της αορτής και καταλήγει στην αριστερή πλευρά στο τμήμα της 
κοιλιακής αορτής. Αποκρύψαμε το τοίχωμα της αορτής για να διακρίνουμε καθαρά τα 
διανύσματα της ταχύτητας. Το πρώτο και πιο σημαντικό σχόλιο για τις εικόνες 5.1 και 
5.2 είναι το γεγονός πως οι τιμές των ταχυτήτων κυμαίνονται από 0 έως 5 περίπου 
m/s και στις δύο περιπτώσεις κατά το μήκος της αορτής με εξαίρεση την έξοδο που 
θα σχολιάσουμε παρακάτω. Αυτό σημαίνει πως στο μέγεθος της ταχύτητας δεν 
υπάρχει μεγάλη διαφορά μεταξύ νευτωνικού και μη νευτωνικού ρευστού. Επίσης 
παρατηρούμε στην είσοδο της αορτής η ταχύτητες έχουν μικρή τιμή ενώ αυξάνεται 
πάρα πολύ η τιμή της ταχύτητας στην έξοδο της αορτής όπου υπάρχει και στένωση. 
Γενικά βλέπουμε πως δεν υπάρχουν μεγάλες μεταβολές στην τιμή της ταχύτητας 
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παρά μόνο στην έξοδο όπου υπάρχει μια στένωση και πιθανότατα αυτή η απότομη 
και μη φυσιολογική ιατρικά, αύξηση της τιμής της ταχύτητας να υποδηλώνει πως σε 
εκείνο το σημείο ο ασθενής έχει εμφανίσει αθηροσκλήρωση (πλάκα). Θα πρέπει να 
αναφερθεί αυτό το γεγονός στον γιατρό και να προβεί στις κατάλληλες ενέργειες.  

 

 
 

Εικόνα 5.1: Διανύσματα ταχύτητας για θεώρηση του αίματος ως μη νευτωνικού 
ρευστού 

 

 
 

Εικόνα 5.2: Διανύσματα ταχύτητας για θεώρηση του αίματος ως νευτωνικού ρευστού 
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Στις εικόνες 5.3 και 5.4 θα εστιάσουμε στην έξοδο της αορτής καθώς εκεί 
είδαμε πως υπάρχει μεγάλη αύξηση της ταχύτητας για τις δύο περιπτώσεις. 
 
 

 
 

Εικόνα 5.3: Κατανομή διανυσμάτων ταχύτητας στην έξοδο της αορτής. Μη 
νευτωνικό ρευστό 

 
 
Αυτό που παρατηρούμαι στις εικόνες 5.3 και 5.4 είναι ότι κοντά στα τοιχώματα της 
αορτής οι τιμές των ταχυτήτων μειώνονται αισθητά και τείνουν να πάρουν πολύ 
μικρές ακόμα και μηδενικές τιμές. Το γεγονός αυτό εξηγείται διότι έχουμε επιλέξει την 
συνθήκη μη ολίσθησης(no slip) στο τοίχωμα της αορτής και αυτό έχει ως αποτέλεσμα 
το ρευστό να μην ολισθαίνει πάνω στα τοιχώματα της αορτής κατά την διαδικασία της 
προσομοίωσης και έτσι η εφαπτομενική ταχύτητα κοντά στα τοιχώματα της αορτής 
είναι μηδέν. 
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Εικόνα 5.4: Κατανομή διανυσμάτων ταχύτητας στην έξοδο της αορτής. Νευτωνικό 
ρευστό 

 
 
 

Στην συνέχεια παρουσιάζονται οι ροϊκές γραμμές του ρευστού για τις δύο 
περιπτώσεις του μη νευτωνικού και του νευτωνικού ρευστού. Έχουν φορά από την 
δεξιά μεριά (είσοδος) προς την αριστερή μεριά (έξοδος). 
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Εικόνα 5.5: Προβολή ροϊκών γραμμών του ρευστού. Μη νευτωνικό ρευστό 
 

 
 

Εικόνα 5.6 : Προβολή ροϊκών γραμμών του ρευστού. Νευτωνικό ρευστό 
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5.2 ΚΑΤΑΝΟΜΗ ΤΑΣΕΩΝ ΣΤΑ ΤΟΙΧΩΜΑΤΑ ΤΗΣ ΑΟΡΤΗΣ  
 

Στις επόμενες εικόνες(5.7 και 5.8) παρουσιάζονται οι διατμητικές τάσεις στα 
τοιχώματα της αορτής για τις δύο περιπτώσεις. 
 

 
 

Εικόνα 5.7: Κατανομή διατμητικών τάσεων στα τοιχώματα της αορτής. Μη νευτωνικό 
ρευστό 
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Εικόνα 5.8: Κατανομή διατμητικών τάσεων στα τοιχώματα της αορτής. Νευτωνικό 
ρευστό 

 
 

Αρχικά παρατηρούμε πως δεν υπάρχουν διαφορές ούτε στην τιμή τάσεων 
μεταξύ νευτωνικού και μη νευτωνικού ρευστού. Κυμαίνονται από 0.06 έως 185Pa 
περίπου οι τιμές των τάσεων στα τοιχώματα και στις δύο περιπτώσεις. Γενικά 
βλέπουμε πως δε υπάρχουν περιοχές με πολύ υψηλές τιμές διατμητικών τάσεων εάν 
εξαιρέσουμε την έξοδο του ρευστού όπου υπάρχει και μια στένωση. Οι περιοχές οι 
οποίες έχουν χαμηλές τιμές διατμητικών τάσεων είναι πολύ επικίνδυνες να 
εμφανίσουν κάποια στιγμή αρτηριοσκλήρυνση (αθηρωμάτωση). Στις περιοχές που οι 
διατμητικές τάσεις είναι πολύ υψηλές υπάρχει κίνδυνος να προκληθεί μηχανική 
βλάβη στο ενδοθήλιο.  

Το ενδοθήλιο αποτελεί τον εσωτερικό από τους τρείς χιτώνες του τοιχώματος 
των αρτηριών. Αποτελεί μια διαχωριστική επιφάνεια μεταξύ του αίματος και της 
αρτηρίας. 
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Όλα τα ανωτέρω είναι πιθανές ενδείξεις και θα πρέπει να γνωστοποιηθούν 
στον θεράποντα ιατρό, ώστε να συνδυαστούν με τις εξετάσεις αίματος και το ιατρικό 
ιστορικό του ασθενούς για την ακριβέστερη διάγνωση και δυνητική πρόληψη. 

 
 

5.3 KATANOMH ΑΡΙΘΜΟΥ REYNOLDS 
 

Στις παρακάτω εικόνες μπορούμε να δούμε την κατανομή του αριθμού 
Reynolds. 
 

 
 

Εικόνα 5.9: Κατανομή Reynolds. Μη νευτωνικό ρευστό 
 
 
 
 
 
 
 
 
 
 
 
 



55 
 

 
 

 
 

Εικόνα 5.10: Κατανομή Reynolds. Νευτωνικό ρευστό 
 
 

Και σε αυτά τα διαγράμματα παρατηρούμε πως δεν υπάρχουν διαφορές στις 
τιμές του αριθμού Reynolds μεταξύ νευτωνικού και μη νευτωνικού ρευστού. Οι τιμές 
του Reynolds κυμαίνονται από περίπου 0.2 έως 800, με τις μεγαλύτερες τιμές να 
βρίσκονται στην στένωση όπως περιμέναμε. Αξίζει να σημειωθεί πως σε όλη σχεδόν 
την αορτή η τιμή του Reynolds δεν ξεπερνά το 150. Άρα η υπόθεση μας για μοντέλο 
στρωτής ροής επαληθεύεται. Βλέπουμε πως στην έξοδο της αορτής όπου υπάρχει 
και η στένωση ο αριθμός Reynolds φτάνει το 800 και στις δύο περιπτώσεις. 
Πιθανότατα σε εκείνη την περιοχή να έχουμε μία μεταβατική ροή η ακόμα και 
ξεκίνημα μιας τυρβώδους ροής.  
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5.4 ΚΑΤΑΝΟΜΗ ΣΤΡΟΒΙΛΟΤΗΤΑΣ 
 

 
 

Εικόνα 5.11: Κατανομή στροβιλότητας. Μη νευτωνικό ρευστό 
 

 
Η μέγιστη τιμή βρίσκεται στην στένωση με τιμή 29600 1/sec ενώ η μικρότερη τιμή 
είναι 4.15 1/sec 
 

 
 

Εικόνα 5.12: Κατανομή στροβιλότητας. Νευτωνικό ρευστό 
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Η μέγιστη τιμή βρίσκεται στην στένωση με τιμή 30000 1/sec ενώ η μικρότερη 
τιμή είναι 4.45 1/sec 

Παρατηρούμε πως και σε αυτήν την περίπτωση δεν υπάρχει μεγάλη διαφορά 
στις τιμές που λαμβάνει το μέγεθος της στροβιλότητας μεταξύ νευτωνικού και μη 
νευτωνικού ρευστού. 
 
 
 

5.5 ΚΑΤΑΝΟΜΗ ΙΞΩΔΟΥΣ 
 

Η μόνη περίπτωση που θα έχουμε διαφορετικά αποτελέσματα στις τιμές 
μεταξύ μη νευτωνικού και νευτωνικού ρευστού είναι στις τιμές του ιξώδες, αφού στην 
πρώτη περίπτωση που έχουμε μη νευτωνικό ρευστό το ιξώδες θα παίρνει διάφορες 
τιμές ενώ στην δεύτερη περίπτωση που έχουμε νευτωνικό ρευστό το ιξώδες θα έχει 
σταθερή τιμή. 

 

 
 

Εικόνα 5.13: Κατανομή Ιξώδους σε μη νευτωνικό ρευστό 
 
 

Στην εικόνα 5.13 παρατηρούμε ότι η τιμή του ιξώδους μεταβάλλεται και αυτό 
είναι κάτι το οποίο το περιμέναμε διότι δεν έχει  σταθερή τιμή στην περίπτωση ενός 
μη νευτωνικού ρευστού. Η τιμή του κυμαίνεται από 0.0035 kg/(m∙s) και φτάνει έως 
την τιμή του 0.00835 kg/(m∙s). Στην εικόνα 5.14 βλέπουμε το ιξώδες κατά μήκος της 
αορτής να έχει την ίδια τιμή. Αυτό είναι αναμενόμενο διότι το ρευστό θεωρήθηκε 
νευτωνικό και άρα είχε σταθερή τιμή. 
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Εικόνα 5.14: Κατανομή ιξώδους σε νευτωνικό ρευστό 
 
 

 

5.6 ΚΑΤΑΝΟΜΗ ΠΙΕΣΗΣ 
 

 
 

Εικόνα 5.15: Κατανομή πίεσης σε μη νευτωνικό ρευστό 
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Εικόνα 5.16: Κατανομή πίεσης σε νευτωνικό ρευστό 
 
 

Αυτό που παρατηρείται στις εικόνες 5.15 και 5.16 είναι αρχικά το γεγονός πως 
οι τιμές της πίεσης έχουν πολύ μικρές διαφορές και στις δύο περιπτώσεις. Επίσης 
αυτό που διακρίνουμε είναι το γεγονός  πως στην είσοδο της αορτής καθώς και στο 
τμήμα του αορτικού τόξου δημιουργούνται μεγάλες πιέσεις γεγονός το οποίο μπορεί 
να δημιουργήσει κάποιες επιπλοκές στην ομαλή λειτουργία της αορτής. Ενδεχομένως 
να γίνει αποκόλληση του ενδοθηλίου. Όλα αυτά βέβαια υπό την αίρεση 
αιματολογικών εξετάσεων που θα κάνει ο ασθενής.   
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Ακολουθούν άλλες δύο εικόνες 5.17 και 5.18 που παρουσιάζουν την κατανομή 
της δυναμικής πίεσης. 
 

 
 

Εικόνα 5.17: Κατανομή πίεσης σε μη νευτωνικό ρευστό 
 

 
 

Εικόνα 5.18: Κατανομή πίεσης σε νευτωνικό ρευστό 
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Στις εικόνες 5.17 και 5.18 βλέπουμε μικρές διαφορές στις τιμές της πίεσης για 

τις δύο διαφορετικές περιπτώσει μας. Η δυναμική πίεση όπως αναμενόταν παίρνει 
την μέγιστη τιμή της στην στένωση όπου έχει και την μεγαλύτερη ταχύτητα. 

 

5.7 ΥΠΕΡΤΑΣΗ-ΥΠΟΤΑΣΗ 
 

Οι παραπάνω προσομοιώσεις και τα αποτελέσματα που πήραμε είχαν να 
κάνουν με την περίπτωση ενός υγιούς ατόμου. Θελήσαμε να πραγματοποιήσουμε 
ακόμα δύο προσομοιώσεις οι οποίες έγιναν υπό άλλες συνθήκες. 

 Ένα πολύ συνηθισμένο γεγονός είναι κάποιος άνθρωπος να έχει υπόταση ή 
υπέρταση. Θελήσαμε λοιπόν να εξετάσουμε αυτές τις δύο περιπτώσεις και να 
συγκρίνουμε τα αποτελέσματα της πίεσης και των διατμητικών τάσεων που 
πρόεκυψαν από τις δύο αυτές προσομοιώσεις. Τις προσομοιώσεις τις 
πραγματοποιήσαμε θεωρώντας το αίμα μη νευτωνικό ρευστό. 

 
Στις εικόνες 5.19 και 5.20 βλέπουμε την κατανομή της πίεσης κατά μήκος της 

αορτής: 
 
 

 
 

Εικόνα 5.19: Κατανομή πίεσης στην περίπτωση της υπέρτασης 
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Εικόνα 5.20: Κατανομή πίεσης στην περίπτωση υπότασης 
 
 
 

Αυτό που παρατηρούμε στις εικόνες 5.19 και 5.20 είναι το γεγονός ότι υπάρχει 
μια διαφορά μεταξύ των δύο πιέσεων. Αυτό είναι απόλυτα φυσιολογικό καθώς στην 
υπόταση η πίεση είναι μικρότερη από ότι στην περίπτωση της υπέρτασης. Επίσης 
διακρίνουμε και στις δύο εικόνες ότι στην είσοδο της αορτής και στο τμήμα του 
αορτικού τόξου παρουσιάζονται οι μεγαλύτερες πιέσεις. 

Στις εικόνες 5.21 και 5.22 διακρίνουμε τις κατανομές των διατμητικών τάσεων 
στα τοιχώματα της αορτής.   
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Εικόνα 5.21: Κατανομή διατμητικών τάσεων στην περίπτωση υπέρτασης 
 

 
 
Εικόνα 5.22: Κατανομή διατμητικών τάσεων στην περίπτωση υπότασης 
 



64 
 

 
Αυτό που βλέπουμε στις εικόνες 5.21 και 5.22 είναι ότι στην περίπτωση της 

υπέρτασης οι διατμητικές τάσεις έχουν μεγαλύτερη τιμή σε σχέση με τις τιμές των 
διατμητικών τάσεων στην υπόταση. που υπάρχουν στην αορτή. Οι περιοχές οι 
οποίες έχουν χαμηλές τιμές διατμητικών τάσεων είναι πολύ επικίνδυνες να 
εμφανίσουν κάποια στιγμή αρτηριοσκλήρυνση (αθηρωμάτωση). Στις περιοχές που οι 
διατμητικές τάσεις είναι πολύ υψηλές υπάρχει κίνδυνος να προκληθεί μηχανική 
βλάβη στο ενδοθήλιο.  

Όλα τα ανωτέρω είναι πιθανές ενδείξεις και θα πρέπει να γνωστοποιηθούν 
στον θεράποντα ιατρό, ώστε να συνδυαστούν με τις εξετάσεις αίματος και το ιατρικό 
ιστορικό του ασθενή για την ακριβέστερη διάγνωση και δυνητική πρόληψη. 
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ΣΥΜΠΕΡΑΣΜΑΤΑ 

 
 

Στη παρούσα πτυχιακή εργασία με τίτλο «Μελέτη παλμικής ροής αίματος σε 
πρότυπη αρτηρία με την χρήση του υπολογιστικού προγράμματος FLUENT» 
μελετήθηκε και προσομοιώθηκε παλμική ροή αίματος σε πρότυπη αρτηρία (αορτή) 
με την χρήση του υπολογιστικού προγράμματος ρευστοδυναμικής Ansys Fluent. Η 
γεωμετρία της αορτής ανακτήθηκε από υπολογιστική τομογραφία. 

Στο τρίτο κεφάλαιο κάναμε όλες τις απαραίτητες διαδικασίες με σκοπό την 
δημιουργία ενός υπολογιστικού πλέγματος. Δημιουργήσαμε δύο πλέγματα με 
διαφορετικές παραμέτρους και διαλέξαμε το καλύτερο από τα δύο με κριτήριο τόσο το 
υπολογιστικό φορτίο, όσο και την ακρίβεια. Για την διαδικασία της δημιουργίας του 
πλέγματος χρησιμοποιήσαμε το λογισμικό ICEM CFD. Το συμπέρασμα που βγάλαμε 
όσον αφορά την δημιουργία πλεγμάτων είναι ότι πρέπει να εστιάζουμε στο κομμάτι 
της γεωμετρίας που μας ενδιαφέρει πιο πολύ και να σχεδιάζουμε το πλέγμα ανάλογα 
με την ακρίβεια που απαιτεί κάθε περιοχή. 

Στο τέταρτο κεφάλαιο πραγματοποιήσαμε δυο προσομοιώσεις. Στην πρώτη 
προσομοίωση θεωρήσαμε το αίμα μη νευτωνικό ρευστό και μελετήσαμε την παλμική 
ροή στην αορτή μας. Στην συνέχεια πραγματοποιήσαμε και την δεύτερη 
προσομοίωση αλλά αυτή την φορά θεωρήσαμε το αίμα ως νευτωνικό ρευστό. 
Σκοπός των δυο αυτών προσομοιώσεων ήταν να εξάγουμε αποτελέσματα τα οποία 
συμφωνούν με την θεωρία της ρευστοδυναμικής και επίσης να δούμε αν η θεώρηση 
πολλών ερευνητών, ότι το αίμα είναι νευτωνικό ρευστό λόγω των υψηλών ρυθμών 
διάτμησης που επικρατούν στις μεγάλες αρτηρίες, ισχύει τελικά. 

Τα αποτελέσματα των προσομοιώσεων που κάναμε συμβαδίζουν με την 
θεωρία της ρευστοδυναμικής και άρα μπορούμε να πούμε πως η προσομοίωση σε 
αρτηρία παλμικής ροής που κάναμε είναι επιτυχημένη. 

Αρχικά το συμπέρασμα που βγήκε για την ρεολογία του αίματος είναι ότι 
τελικά για μεγάλες αρτηρίες ισχύει η θεώρηση πολλών ερευνητών ότι συμπεριφέρεται 
ως νευτωνικό ρευστό. 

Το αίμα λοιπόν μπορεί να θεωρείται νευτωνικό ρευστό σε περιπτώσεις 
προσομοίωσης μεγάλων αρτηριών. Η αρτηρία που μελετήσαμε εμείς είναι η 
μεγαλύτερη αρτηρία του σώματος, η αορτή, και τα αποτελέσματα έδειξαν πως είναι 
πολύ καλή προσέγγιση η θεώρηση του αίματος ως νευτωνικού, τουλάχιστον όσον 
αφορά προσομοίωση σε αρτηρίες μεγάλης διαμέτρου. Οι διαφορές μεταξύ των 
μεγεθών στις δυο περιπτώσεις ήταν πολύ μικρές και έτσι η επιλογή του νευτωνικού 
ρευστού προσεγγίζει αρκετά την συμπεριφορά του αίματος. 
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Αφού λοιπόν βγήκε το πρώτο συμπέρασμα για την συμπεριφορά του αίματος, 
θα εστιάσουμε στις τιμές των μεγεθών που μελετήσαμε. Παρατηρώντας τα 
αποτελέσματα των διανυσμάτων ταχύτητας βλέπουμε πως δεν αναπτύσσονται 
μεγάλες ταχύτητες στην αορτή παρά μόνο στην στένωση όπου πιθανότατα ο 
ασθενής έχει αθηρωματική πλάκα και πρέπει να επισκεφτεί άμεσα γιατρό. Επίσης η 
θεώρηση μας ότι η ροή είναι στρωτή επαληθεύτηκε καθώς κατά μήκος της αορτής 
δεν αναπτύχθηκαν τιμές Reynolds μεγαλύτερες από το 150. Μόνο στην έξοδο λόγω 
της στένωσης υπήρξε μία αύξηση του αριθμού  Reynolds που ίσως να δηλώνει την 
αλλαγή της ροής σε μεταβατική ή τυρβώδη. Για να είμαστε σίγουροι ωστόσο για την 
θεώρηση αυτή, κάναμε προσομοιώσεις με τα μοντέλα k-ε και k-ω που σχετίζονται με 
τυρβώδης ροές για να το εξακριβώσουμε. Τα αποτελέσματα έδειξαν μικρές διαφορές 
σε σχέση με τα αποτελέσματα για στρωτή ροή και συνεπώς δεν υπάρχουν ενδείξεις 
ανάπτυξης ροών τύρβης. 

Μελετήσαμε ακόμα τις διατμητικές τάσεις στα τοιχώματα της αορτής για να 
διαπιστωθούν τυχόν ενδείξεις για εμφάνιση αρτηριοσκλήρυνσης η κάποιου 
ανευρίσματος στο μέλλον. Ασθένειες οι οποίες είναι πολύ επικίνδυνες. Στην 
συγκεκριμένη αορτή υπάρχει μια περιοχή χαμηλών διατμητικών τάσεων 
(παράγραφος 5.2) που μπορεί στο μέλλον να εμφανίσει αθηρωμάτωση (πλάκα). 
Επίσης στις περιοχές που οι διατμητικές τάσεις είναι πολύ υψηλές υπάρχει κίνδυνος 
να προκληθεί μηχανική βλάβη στο ενδοθήλιο. 

Το συμπέρασμα λοιπόν είναι ότι τα αποτελέσματα τα οποία προέκυψαν μετά 
από τις προσομοιώσεις με το πρόγραμμα υπολογιστικής ρευστοδυναμικής Fluent 
συμφωνούν με τη θεωρία της ρευστοδυναμικής σε μεγάλο βαθμό. Μπορούμε λοιπόν 
να πούμε ότι η χρήση υπολογιστικών προγραμμάτων αποτελεί ένα πολύ σημαντικό 
εργαλείο για την επιστήμη και τον άνθρωπο. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



67 
 

 
 
 
 

ΠΑΡΑΔΟΧΕΣ 
 
 
 
 
Για να μπορέσουμε να πραγματοποιήσουμε τις παραπάνω προσομοιώσεις 

έχουμε κάνει κάποιες παραδοχές: 
 

· Θεωρήσαμε όλες τις μεταβολές ισόθερμες καθώς δεν μελετάμε το 
πρόβλημα με θερμοκρασιακές αλλαγές. Κάτι τέτοιο θα άλλαζε τα 
χαρακτηριστικά της παλμικής μας ροής 

· Θεωρήσαμε το τοίχωμα της αορτής ότι είναι ακίνητο, χωρίς 
ελαστικότητα και απαραμόρφωτο καθώς εμάς μας ενδιέφερε η 
συμπεριφορά του ρευστού, η ροή του και η επίδραση που έχει στην 
αορτή.  
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ΠΡΟΤΑΣΕΙΣ ΓΙΑ ΒΕΛΤΙΩΣΗ 
 
 
 
Υπάρχουν κάποια σημεία στην πτυχιακή που θα μπορούσαν να αναλυθούν σε 

επόμενες πτυχιακές. 
Μια πρόταση πολύ ενδιαφέρουσα θα ήταν να μελετηθεί η αορτή 

χρησιμοποιώντας ελαστικά τοιχώματα και να εξαχθούν αποτελέσματα για τις τάσεις 
των τοιχωμάτων. 

Επίσης θα μπορούσε να πραγματοποιηθεί η προσομοίωση χρησιμοποιώντας 
μια συνάρτηση ταχύτητας στην είσοδο του ρευστού και όχι πίεσης. 

Ακόμα θα μπορούσε να χρησιμοποιηθεί κάποιο άλλο μοντέλο στον 
προσδιορισμό του ιξώδες σε μη νευτωνικό ρευστό και να γίνει η σύγκριση με το 
μοντέλο Carreau. 
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